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Chapter 1 Welcome
Congratulations on your purchase!

If you are creating traffic or site plans as part of your business, rest assured that you have made the right decision in purchasing
RapidPlan. It is without doubt the easiest and fastest way to create plans for your works. Please read on to learn a little more
about Invarion, and our plans for RapidPlan.

1.1 About Invarion
Invarion is the software firm behind the design and creation of RapidPlan. Many customers will remember our original traffic
control plan software Planman which was the first of our offerings. RapidPlan builds upon the functionality of the Planman
system, with a brand new drawing engine and countless new features and functions. Indeed, RapidPlan has come a long way in
terms of sophistication from the initial software program which is why users all over the world have made the switch.

1.2 Our Plans for RapidPlan
We are committed to the continual improvement of RapidPlan, and we actively encourage feedback from users around the
world who would like to see improvements, additions or modifications to the system. It's this feedback that helps us shape our
future releases for our customer base. If you have an idea for a new feature, or a suggestion for an improvement or change to
the version of RapidPlan you are using, please visit our website at rapidplan.com and look for the feedback forms (located in
the Contact Us section).

1.3 If You Need Support
You can communicate with us over contact form on our webpage https://rapidplan.com/Home/ContactUs or contact the
Invarion technical support line in your country - please check out our website https://invarion.com/locations for contact
details.
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Chapter 2 Getting Started
This section will help you install RapidPlan on your system(s) and also explain the registration process that you will need to
follow to unlock your system for usage.

2.1 Getting up and Running...

2.1.1 System requirements
Before downloading the software, please ensure your machine complies with the minimum specifications recommended for
running RapidPlan.

A list of the minimum specifications can be reviewed here:

https://rapidplan.com/pages/system-requirements

2.1.2 Downloading the application
To start things up, you need to install the Invarion Launcher. You can download the Invarion Launcher at:

https://rapidplan.com/pages/launcher-installation

The Invarion Gateway has only recently been replaced by the Invarion Launcher. This is our new distribution channel for
desktop versions of RapidPlan and RapidPath, ensuring your software is secure and always up-to-date.

Please also note that for existing customers, the old Invarion Gateway will be gradually phased out over the
coming months. We therefore recommend switching to the Launcher as soon as possible to avoid any interruptions to your
service.

2.1.3 Invarion Launcher Client Intro Screen
Once downloaded, you can login to the Launcher using the username and password provided by Invarion.

If it's the first time a user is logging in, you will be presented with the below instructions in the Invarion Launcher.

Figure 2.1 Launcher log in

Clicking on Sign In will direct the user to a browser window to enter the username and password provided by Invarion, once
the credentials have been entered and the details are accepted, you will be prompted to close the browser window and return
to the Launcher.

If you have forgotten your password, simply click the 'Forgot your password' link under the log in area, you will then be
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sent to another Browser window with steps on resetting your password.

Figure 2.2 Browser log in

Once the user is logged into the Launcher client, applications will display that are assigned to that user. Clicking 'Open' will
launch that specific application.

If an update is required, the Launcher will automatically download and apply this prior to launching the application.

To manually check for any updates, simply click the refresh icon in the top left of the Launcher window.

Figure 2.3 Launcher client

To check which version of RapidPlan you are using, simply click the drop down arrow.

This will detail the current RapidPlan version you are using, signage packages and any applicable add-ons for your user profile.
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Figure 2.4 Launcher add ons

Clicking the hamburger icon in the top left of the window will allow you to access the Settings menu.

Here, you can specify the default downloads folder.

If you have both RapidPlan & RapidPath respectively, you can specify which application will launch by default when the
Launcher is opened or when any .TCP files are opened from your PC.

Figure 2.5 Launcher settings

The 'Show advanced settings' button contains features that our support team will advise you to access, if you encounter any
technical issues.

We advise only to access these settings in those circumstances.

2.1.4 Changing and resetting password
Changing Your Password

If you want to change your password, simply click your user profile email, found in the top right of the Invarion Launcher, you
will then be directed to your Invarion account page in a browser window.
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Figure 2.6 Invarion account

Once you select 'Reset password' the below window will display, allowing you to change your password.

Figure 2.7 Change Password Online
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2.2 Working Offline or via Proxy
For users who have limited internet connectivity at their workstation a proxy mode is available. This setup requires a networked
server with internet access. Please contact Invarion for more information on utilizing this feature.

RapidPlan also allows usage of the program even without an Internet connection with the Work Offline option. For a users
login to remain valid,they will need to login online at least once every 14 days.
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2.3 Transferring License
Based on the current License Agreement in place of "One license per user, per machine", a RapidPlan account can only be
activated on a single user profile on a particular computer. Activation on another machine or on another profile on the same PC
requires another RapidPlan license, otherwise, subsequent activation of the same license will render the program automatically
deactivated on the original user account profile.

2.3.1 Change of User
If a license is assigned to a new user who, presumably, would want to use a different login username, Invarion Support must be
duly notified of such a change so that the necessary update will be made on the records of the license involved. Without prior
notification, the new user using his own email address as username will not be able to log in due to an account mismatch.

Check Invarion website for the corresponding Support contact number of the country you're in.

2.3.2 Transfer to Another Machine or Computer
In the event of a transfer to another PC, the program will ask the user whether they want to reactivate his account on the new
PC.

Figure 2.8 Account Activated Elsewhere

If a user decides to reactivate their license, it will be disabled while being transferred. Generally the process takes approximately
8 hours, after which the user will be able to log in as normal.
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Chapter 3 The RapidPlan Screen
3.1 Welcome to RapidPlan!
When executing RapidPlan from the Invarion Gateway, you will be presented with a Welcome screen that offers several options
to choose from.

3.1.1 The Components of the Welcome Screen

Figure 3.1 Components of the Welcome screen

New Plan Wizard

Use the New Plan Wizard to quickly specify all properties of a new plan you're creating. The wizard integrates the creation of
five basic plan types: Blank canvas, Base map, Static template, From PDF, and Auto template.

New Default Plan

This selection provides you with a default canvas. Default plan settings can be amended and saved in Tools > Preferences.

Open Plan

Saved plans can be loaded with this selection.
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Recent Plans

Recently saved plans can be quickly accessed from here, hovering over each plan will highlight them on the Plan locations map.

Tutorials

Selecting this takes you to the Invarion RapidPlan YouTube page where you have free access to video tutorials covering
topics from the basic RapidPlan overview, using available tools and controls, up to some more advanced tips and uses.

RapidPlan News

This section provides you with the latest updates and news from RapidPlan.

Plan locations

The plan locations map plots your plans on a map. By clicking a pin, you can view plan information, such as when the plan was
last accessed and modified. You can also right-click on a pin and select 'Show Google Street View' to see street view images in
your web browser (subject to Street View image availability at the specific location).

Figure 3.2 Plan locations
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3.2 Your Workspace

For the purpose of this explanation we will be using the New Default Plan in the following
section.
Before you get started with RapidPlan, you should probably get to know your way around the main screen. It has been
designed to be intuitive, easy to follow and to allow you the maximum available working space to create your traffic plan.

There are three main components of the RapidPlan workspace:

The Toolbar
The Palettes
The Canvas

Organizing your workspace is simple as each of the items that sit on the canvas can be moved around. Generally, your screen
will be laid out similar to as is shown below.

Figure 3.3 Components of the Workspace

3.2.1 The Toolbar
The toolbar houses most of the "plan-wide" tools that you will use for your plan such as the flip tools, zoom tools, and various
special mode options (like toggle fax mode or sign designations - these are explained further in Chapter 4).

Figure 3.4 The Toolbar
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3.2.2 The Palettes
There are five main palettes that will appear on the screen initially, which between them contain virtually all the tools you will
use in creating your plan. There are three tabs that appear vertically docked to the left of your canvas; the signs palette, the
scratchpad and the tools palette, while the properties and layers tabs will appear to the right of your canvas. When hovered
over with your mouse the palettes become visible, you then have the option to click on pin/unpin (right corner of the palette) or
to click on the "x" to close the palette. You can also right click on the top bar of the palette and choose to have your palette float
anywhere on the screen.

Figure 3.5 Pin - Unpin

3.2.2.1 The Signs Palette

This palette contains road signs you will need to create your traffic guidance scheme. It also carries an array of street furniture
and vehicular plant which you can use as part of your site plan. The signs are listed by state allowing you to set the region you
are working in. Depending on which countries sign pack you have installed, you may have multiple regions to choose from (for
instance in both the United States and Australia, there are various State signage packs available to choose from as well as the
national signage). The button on the top left of the palette allows you to select your state displaying the relevant signs that you
are likely to need. The other two buttons allow you to search signs by category or using a search bar.

See Chapter 12 for information on making and custom saving signs.

Figure 3.6 Signs
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3.2.2.2 The Tools Palette

The Tools Palette contains most of the tools you will use to construct the features of your plan.

Figure 3.7 Tools

You can hover your mouse over each Tool to reveal its contents. Continue reading for more information on what each tool icon
contains.

1. Roads - This displays each of the tools you can use to construct your road way.

Chapter 6 and Chapter 7 covers this tool set.

Roads

Road Turn lane

Arc road Roundabout

Road corner Road region

Intersection Editor

Table 3.1 Roads
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2. Infrastructure - This displays infrastructure you may need to construct your plan including train tracks, bicycle lanes, etc.

Chapter 7 covers this tool set.

Infrastructure

Train tracks Crosswalk

Island Bicycle lane

Parking bay Sidewalk

Table 3.2 Infrastructure

3. Devices - This displays devices such as delineators, arrow board and lane status.

Chapter 9 covers this tool set

Devices

Delineator Buffered delineator

Arrow board VMS board

Lane status LUMS board

Multi message sign

Table 3.3 Devices

4. Markings - This displays various lane markings.

Chapter 7 covers this tool set

Markings

Lane marker Flush median

Chevron flush median Lane mask

Road mask

Table 3.4 Markings
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5. Zones - This includes a work area zone and a safety zone.

Chapter 9 covers this tool set

Zones

Work area Safety zone

Table 3.5 Zones

6. Annotations - This includes necessary annotation features for your plan such as a scale marker and a legend box.

Chapter 9 covers this tool set

Annotations

North Arrow Scale marker

Legend box Manifest box

Titlebox Number stamper

Zoomed view box

Table 3.6 Annotations

7. Markers - This displays distance markers, an area marker and an angle marker.

Chapter 9 covers this tool set.

Markers

Distance marker Combined distance
marker

Offset distance marker Angle marker

Area marker Combined offset distance
marker

Table 3.7 Markers
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8. Lines - This displays various line shapes that can be used.

Chapter 10 covers this tool set

Lines

Polyline Spline

Bezier Arc

Arrow Marked path

Table 3.8 Lines

9. Shapes - These simple shape tools allow you to create your own objects and signs for your plans.

Chapter 10 covers this tool set

Shapes

Rectangle Elipse

Rounded rectangle Polygon

Filled spline Filled Bezier

Grid Arc pie

Cloud Shape

Table 3.9 Shapes

10. Text - These text options can allow you to add a text box, name roads, hyperlinks and create signs.

Chapter 10 covers this tool set
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Text

Text object Text box

Text pair Arrow text

Callout box Path text

Text table Hyperlink

Table 3.10 Text
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11. Image - This allows you to open an image from your computer to your plan.

Image

Import image

Table 3.11 Import image

3.2.2.3 The Scratch Pad

The Scratch Pad is used to store objects that you commonly use to make them easily accessible.

Figure 3.8 The Scratch Pad

To place an object in the scratch pad palette, select the object then right click and select Add to Scratchpad.

Figure 3.9 Add object to Scratch Pad
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3.2.2.4 The Properties Palette

The Properties palette displays all the information pertaining to any selected signs, tools, markers or objects. This is where you
can change fonts, colors, lane markers, etc. of the selected feature.

Figure 3.10 The Properties Palette

You can also double-click an item from your plan to display the property parameters in Quick Edit mode.

Figure 3.11 The Properties Options

3.2.3 The Canvas
The canvas is the section of the screen where you will actually create your traffic plan. The RapidPlan canvas is both versatile
and powerful, and it has many features which will assist you in your plan creation. We have dedicated the entire next Chapter to
the canvas and its features.
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Chapter 4 The Canvas
More than just a place to draw...

The RapidPlan canvas offers more than just a place for you to draw your plan. It has a number of very important features and
functions that you must learn to make use of if you are going to get the most out of your system.

4.1 The New Plan Wizard
The first step in RapidPlan is choosing a canvas to work on. The New Plan Wizard allows you to select a type of plan and specify
details of your plan (such as scale, print region, etc.) before you begin (which a New Default Plan does not).

The New Plan Wizard can be accessed from the Quick Start section of the Welcome to RapidPlan tab. If this tab is closed, the
wizard can also be accessed by going to File > New Plan Wizard.

Figure 4.1 The New Plan Wizard
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Once you have selected the New Plan Wizard option, you will have four plan types to choose from in step 1:

Blank Canvas
Base Map
Static Templates
Auto Template
From PDF

Figure 4.2 Select Plan Type

After you select your plan type, step 2 allows you to enter plan details, such as a title, author, comments and relevant job dates.
You can also choose a print region, set a scale and enter your job location site.

If you choose not to enter any details here, a default print region and scale will be set and any details can be changed at any
time from the Properties Palette.
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4.1.1 Blank Canvas
Selecting the blank canvas option will provide you with a plain canvas to draw your plan on.

To create a Blank Canvas Plan:

Select New Plan Wizard in the Quick Start section of the Welcome to RapidPlan page.

In step 1, select Blank Canvas.

In step 2 enter your plan's details and choose a print region and scale if needed.

In this step, if you scroll down you can also add a job location to make the plan searchable by location.

Once you are ready, select Create Plan in the top right of the window.

Figure 4.3 Enter Plan Details

Note: Selecting a job location with this plan type only makes it searchable by location, if you want to use the integrated
mapping feature, see Base Map below.
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4.1.2 Base Map
Select this plan type if you're drawing a plan for a specific job site. It will let you display a site preview map, import aerial
photos as the plan's background and draw road networks automatically.

Creating a New Plan from a Base Map:

Select New Plan Wizard in the Quick Start section of the Welcome to RapidPlan page.

In step 1, select Base Map.

In step 2 enter your plan details and choose a print region and scale, or leave them as default.

Scroll down to Job Location and type in the address for your job in the search bar and click Search. (Figure 4.4.)

Select Create Plan and your plan will load on your canvas as shown in Figure 4.5.

Note: in the Properties Palette you can change the provider of the map from omniscale, satellite and hybrid.

Figure 4.4 Job location search
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Figure 4.5 Base Map Canvas

Integrated Mapping is covered further in Chapter 14
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4.1.2.1 Base Map Bearing

The bearing of a base map is adjustable, enabling you to draw plans at any orientation. To adjust the base map bearing:

1. Create a new plan in new plan wizard
2. Select the Base map plan type
3. When choosing job location, adjust bearing to liking as shown in Figure 4.6

Figure 4.6 Base map bearing adjustment

The base map bearing can also be adjusted in the properties tab on the right hand side once map has already been inserted
into the plan as seen in Figure 4.7.

Note: To fine tune the bearing adjustment hold down the CTRL key and click and drag the mouse around on the map to get the
desired position.

Figure 4.7 Base map bearing properties
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4.1.3 Static Template
This creates a new plan base on a TCP template selected from a library of typical jobs. Objects imported from the template are
editable so you can adjust the drawing for the specific job you're planning. You can also create your own templates to access
here and work from.

Creating a New Plan from Template

Select New Plan Wizard in the Quick Start section of the Welcome to RapidPlan page.

In step 1, select Static Template.

A New Plan From Template window will appear as shown in Figure 4.8, where you can select your regional template
package and your template.

Once you have chosen your template, click Select Template.

You will be taken back to step 1, now select Next at the top right of the window.

You will now be at the step 2 window where you may see your template's details already there. You can keep these and
the default settings or enter your own details.

Select Create Plan and your template will appear on your canvas as shown in Figure 4.9.

Figure 4.8 New Plan From Template
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Figure 4.9 Canvas Plan From Template

4.1.4 Auto Template
The purpose of the Auto template tool is to semi-automate the process of creating a traffic plan.

Auto templates are capable of laying out basic signage and work site devices at a selected works location.

This also includes parameters such as sign spacing and sign placing. These parameters are calculated based on road properties
such as the road category and the marked speed.

Disclaimer:

The information presented in the auto templates is to be regarded as guidance, and should be altered, when necessary, to fit
the conditions of a particular temporary traffic control zone

Procedures for establishing temporary traffic controls depend on a number of conditions (road configuration, location of the
work, work activity, duration of work, road user volumes, road vehicle mix, road user speeds) and can therefore vary. Selection
of the most appropriate template, to use as a guide for a specific work zone, requires an understanding of each situation.

4.1.4.1 Creating a plan in the Auto Template tool

Select a template from the list of modules available below in Figure 4.10, once selected, click NEXT.
Please note - The Generic Works modules are intended for use in all regions. The templates therefore do not contain
region-specific signs. If using the template as a starting point for your traffic plan, just add signs for your region, as
required.
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Figure 4.10 Auto Template Tool

Once you have chosen a template, search for the specific worksite location and click NEXT. You will then need to select the
road where work will take place. Selectable roads are highlighted in green when you hover over them. Once the road is
been selected, click NEXT.
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Figure 4.11 Select Location

Once you have the road selected, mark out the start and end of your works. This is done by left clicking the first point for
start of the works, then the second point for the end.

Figure 4.12 Define Location

Specify your road dimensions - road width and shoulder width, then click NEXT.
You may be asked further details, such as taper length, and whether or not a buffer zone is required, this will differ for
each region and for the specific template you select.
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Figure 4.13 Specify Road Dimensions

Next, add your Plan details as you would like with any other Plan type (i.e., page size, scale, etc). When this is done, click
Create Plan.
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Figure 4.14 Plan Details

You will then be presented with your auto template on the canvas area. In the top left of your canvas area you will be
presented with a dialogue box, this just confirms your widths and tapers. You can adjust them further, if required.
Clicking the Invert button will switch your works to the opposite side of the road. Reset will set the parameters back to
their defaults.
When all the information is correct, hit Complete and the final template is generated on the canvas area.
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Figure 4.15 Apply Auto Template

4.1.5 From PDF
This creates a new plan from an external PDF document used as a background for your plan. To use this option, select From
PDF at step 1 (Figure 4.2) and an Open window will appear for you to select the PDF from your computer. Select the PDF and
click Import. You will see the PDF previewed in the window. If everything is correct, click Next.

You will now be at the step 2 window where you can enter your plan details. You can keep the default settings or enter your
own details. Once these are entered, select Create Plan and the PDF will appear on your canvas area.
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4.2 Unrestricted Canvas
RapidPlan offers an unrestricted canvas. Virtually limitless in size, this canvas allows you to draw anywhere from a small simple
plan to enormous traffic management plans when you need to. With no restriction on size, it's ideal for applications like races,
parades or large scale, multi-block road closures. It has a range of printing options (see section 4.6 Print Region Guide) which
allow you to print either your entire plan, or just certain sections as you need. This is especially useful for large jobs which have
multiple traffic treatments which you may wish to print into individual plans.

To view or edit your plan properties just use the Properties Palette located to the right of the canvas. Properties can also be
accessed through Edit > Plan Properties or default shortcut key F2.

Figure 4.16 Unrestricted Canvas

4.3 Canvas Navigation
There are essentially four ways that you will need to master when it comes to navigating around the canvas: the origin icon,
scrolling, zooming and shifting between layers

4.3.1 Scroll to Plan Origin
If you become lost in your unrestricted canvas, you can simply click the Scroll to Plan Origin icon and it will take you back to
the origin of your canvas.

Figure 4.17 Scroll to Origin Icon
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4.3.2 Scrolling
Scrolling used around the RapidPlan canvas is very simple, and there are two main ways to do so.

4.3.2.1 The Scroll Bars

Using the scroll bars like virtually all desktop publishing programs (and virtually all other Windows applications) RapidPlan has
a set of scrollbars along the edge of the canvas allowing you to move up, down and across the canvas. This will be the primary
way that you will move around in RapidPlan.

Figure 4.18 Scroll Bars

4.3.2.1 The Canvas-Shift Technique

There is another way to move around the canvas which can be very helpful, especially when you are zoomed a long way in.
Holding down the SPACE BAR, then dragging on the canvas with the mouse will cause the canvas to move and follow the
mouse. It is an extremely efficient way of moving around, because your mouse need not leave the canvas to action the scroll
bars.
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4.3.3 Zooming
Getting to grips with the various zoom techniques is also critical. Seldom will you ever construct a plan at one zoom level for
the entire duration of your plan drawing. There are many zoom features catering to an array of needs.

Figure 4.19 Zoom Toolbar

Zoom
toolbar Description

Reset Zoom - This first option is used to reset the canvas to the set scale

Zoom In - This feature is used to zoom closer into your plan in a general manner

Zoom out - This feature is used to zoom your plan out in a general manner

Select Area to Zoom to - Used by selecting a desired area to zoom to (see the Note*)

Adjust Zoom to see Active Print Area - This feature zooms the print region you have outlined

Adjust Zoom to see all Objects in Plan - This feature zooms to a range that completely encompasses all of
the elements on the plan, but no more. This feature is especially helpful if you lose your bearings on the
unrestricted canvas

Adjust Zoom to see Selected Objects - This feature is used to zoom in on a selected object

Table 4.1 Zoom toolbar

*Note:

Select Area to Zoom to can be done by:

Selecting Select Area to Zoom to in the zoom toolbar.

Click and drag (hold down the mouse button) a box around the area that you wish to magnify.

The area that you encapsulate in your zoom region will be shown in full in your drawing window.
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Figure 4.20 Zoom Region

Alternatively:

for this feature you can simply right-click on a selected area of the canvas and select zoom to selection.

Figure 4.21 Right Click Zoom Method
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4.3.4 Measurement Tools
The measurement tools will enable you to quickly measure distances, angles and areas on your plan. Measurements are
precise, zoom-independent and can be saved as marker objects.

Figure 4.22 Measurement tools button

Click on to the measurement tools button to bring up the toolbar - there are 6 different measurement tools to work with as well
as appropriate measurement units to apply.

Each measurement tool just requires a click and then another click at desired point/s to find the measurement between
different points.

Measurement Tools

Measure distance between 2 points

Measure distance along a path

Measure a rectangular area

Measure circular/elliptical area

Measure any area

Measure angle between two lines

Table 4.2 Measurement tools
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Figure 4.23 Distance along a path measurement
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4.3.5 Changing Layers
The final aspect of navigation around the canvas is cycling through the layers. In older versions of RapidPlan (<3.0) the Layers
List was not shown when initializing RapidPlan. In the new version of RapidPlan, layers palette is visible by default and it's
combined along with Undo history tab. Hovering over the icons with your mouse will display their respective functions.

Figure 4.24 The Layers Palette

See Chapter 13 for more information on Layers.
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4.4 The Concept of "Canvas Ordering"
An important function of the RapidPlan canvas is the ability to order objects. The following diagram demonstrates the concept
of ordering.

Figure 4.25 Bring To Front

Ordering is a very important concept to understand because inevitably during the course of your plan creation you will need to
move something over or under something else that you've already drawn. Fortunately, the ordering process is simple.

39



4.4.1 Changing the Order of Objects
To change the order of objects on the canvas with the mouse:

Select the item that you wish to alter the order of.
Once it is selected, right click on the object.
Select Arrange >

Bring to front - on top
Bring forward - one step forward
Send backwards - one step backward
Send to back - on bottom

Figure 4.26 Order Change

You can also use the keyboard shortcut keys to effect the change, which will be faster and easier.

To change the order of objects on the canvas with the keyboard:

Select the item that you want to alter the order of.
Hold:

ALT + Home - Bring to front
ALT + Page Up - Bring forward
ALT + Page Down - Send backwards
ALT + End - Send to back

Note: the reordering of items happens only inside the scope of the given layer. That is to say that if you are operating on a
lower layer and attempt to bring an object to front, it will still be drawn behind anything on a higher layer.
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4.5 Special Canvas Modes: Fax Mode and Sign Designation Mode
There are two very special canvas modes to assist you in producing a good output from your plan: Fax mode and Sign
Designation mode.

4.5.1 Fax Mode
Have you ever tried to fax something that's in color, and found that it's barely readable at the other end? The reason for this is
because of low contrast between items in the initial document. Fax machines are great at black and white documents, or low
color documents created with fax machines in mind. But for high color documents they can be downright troublesome - that's
why RapidPlan has a very clever Fax mode which converts everything to pure black and white. Every RapidPlan element has a
Fax Mode form.

4.5.1.1 Applying Fax Mode

In order to make faxing easy, each element in RapidPlan has a fax friendly form. This applies to roads, signs, everything. A few
examples are below:

Color mode Fax mode

Figure 4.27 Images in Color Figure 4.28 Images in Fax Mode

Switching Fax mode on and off is simple. Just click on the Toggle Color/Fax mode button from the Options toolbar. Your entire
plan is updated with a single button click.

Figure 4.29 Toggle Color-Fax mode

4.5.1.2 Making Your Own Signs in Fax Mode

You can create and edit fax mode versions of your own signs and objects. This can be done by selecting View > Sign Editor.

See Chapter 12 for more information on Making Your own Signs.
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4.5.2 Sign Designation Mode
Just about every sign packaged with RapidPlan has its unique sign code stored with it. When you activate Sign Designation
mode, the codes are displayed as shown below:

Figure 4.30 Sign Designation Mode

Like fax mode, you can turn Sign Designation mode on and off by clicking on the Toggle Sign Designations button from the
Options toolbar.

Figure 4.31 Toogle Sign Codes

See Chapter 12 for more information on how to create your own signs with stored code designations
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4.6 The Print Region Guide
The key to the Unrestricted Canvas is the blue Print Region guide. This box allows you to build plans that "fit" the shape of a
piece of paper without constraining you to a fixed page size.

Note: You can have more than one Print Region

Figure 4.32 Print Region

Notice in the above example, that its possible to draw outside the bounds of the page guide. That's because (as the name
suggests) it is a print region not a firm boundary.
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4.6.1 Printing Canvas Plans
The importance of the page guide is at it's greatest when printing, because on unrestricted canvas plans there are different
printing options available to you.

You can access the Print Options by clicking on File > Print > Print Options. The Print Options box will open similar to the one
below.

Figure 4.33 Print Options

As you can see there are many options to choose from. Irrespective of what you have on the canvas, everything you have
drawn can be stretched or shrunk to fit on the paper size you choose. There are many available page sizes to choose from as
well as the option for creating a custom size. There is also the option for printing on multiple pages.

If you have more than one print region, or you want to print regions from other plans, you use the Batch printing option.

You can access Batch Printing by clicking on File > Print > Batch Print. There you can add files or add open files, select which
regions you want to print (some or all of them), sort in which order to print (manual sort, sort by alphabetically, creation date or
by last edit).
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Figure 4.34 Batch Printing

If there is more than one print region on added plan, there will be Three Rectangles icon on top right corner. Orange filling of
every rectangle represents different option:

Print just active region

Figure 4.35 Print Active Region

Print all regions on plan

Figure 4.36 Print All Regions

Print just selected region(s)

Figure 4.37 Print Selected Regions
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4.6.2 Print Regions
RapidPlan will only print sections of your plan set inside the print region. In the example below, everything outside the print
region guide is ignored. Multiple print regions can be added to your plan which allows you to designate which print regions to
allow active for printing.

Figure 4.38 Print Regions

Note: The Print Region in this Image is displayed as red.

RapidPlan also allows you to print small sub-sections of your plan. This is especially useful on large traffic plans with multiple
traffic treatments that you want to print on individual sheets of paper. Simply draw your entire plan, mark the section that you
want to see on paper using the Add Print Region icon, then print (or export using File > Export).

By clicking the Add Print Region icon in the tool bar your cursor allow you to create a custom print region by clicking and
dragging your cursor across your plan. Alternatively, you can select the down arrow next to the icon which will give you more
size options for print regions as shown below.

Figure 4.39 Add Print Region

Similar to the previous example, only what is inside the defined blue print region below would be printed to paper. Everything
outside would be ignored.
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Figure 4.40 Alternate Print Region Added

As shown in Figure 4.41 multiple Print Regions can be added to the one plan. Print Region 3 was selected by clicking the printer
icon in the bottom left corner of the print region, highlighting the region as red. If you then place the cursor over a corner of the
region, it becomes an arrow and allows you to change its shape and size of the print region to your preference.

You can remove, activate or deactivate print areas. Only print areas that are Active will print. You can change the Active Print
Region by selecting the printer icon in the desired print region, making the perimeter a bold blue, as seen below.

Note: These changes to the selected print region can also be made in the properties palette.

Figure 4.41 Adjust Print Region

To remove a print region, select the region by clicking on the printer icon in the bottom left of the print region. Then go to Edit
> Remove.
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4.6.2.3 Rotating Print Regions

Print regions placed on the canvas area can also be rotated. This is useful when planning works on a long and windy road,
where each page might need a slightly different bearing

To rotate a print region, click on the printer icon in the bottom left of the print region, then use the rotation handles on each
corner of the print region to rotate to any angle.

When the print region is selected, you can also adjust the exact degree of the bearing in the Properties palette under the
''Region'' subheading.

Figure 4.42 Rotating print regions
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4.6.3 Which Way will RapidPlan Print?
Default RapidPlan print (File > Print active plan or CTRL + P) will print only one, Active print region.

Figure 4.43 Active Print Region

To print more than one print region, use Batch Print

4.6.4 Print Frames and In-Place Print Preview
4.6.4.1 Typical usage scenarios

Reusing standard TCP annotations - if your TCPs need to have a similar titlebox layout (company logo, job details, planner
signature, permit number), you can extract these annotations into a print frame and reuse the frame for different TCPs,
only adjusting the necessary details.
Adjusting annotations to page size - print frames automatically adjust to the current print page size and can auto-rotate
their content to ensure annotations are printed in the same position regardless of whether you're printing in portrait or
landscape orientation.
Aligning annotations with page edges - when the proportions of your print region don't exactly match the proportions of
the page printable area, you're often left with additional margins between the page border and the content that's scaled to
fit inside. Anchoring annotations to frame edges ensured they're aligned with printout borders.
Preventing annotations from obscuring other print regions - when drawing plans with multiple overlapping print regions,
extracting annotations to print frames prevents them from obscuring contents of other regions.
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4.6.4.2 Creating print frames

Print frames can be defined either for individual print regions or for the whole plan (in which case the same frame will be used
for all print regions). To create a plan frame, use the toolbar button. To create a print region frame, double click on the region's
print frame icon. A popup dialog appears, confirming that you're about to create a new print frame. Once a print frame is
created the corresponding icon changes color and can be used to open the frame editor view.

Figure 4.44 Creating print frames

The print frame editor view presents a preview of the printout page with TCP contents scaled to fit inside the page (page size,
orientation, margins and the content scaling mode are based on the current print options). You can now start drawing frame
objects on top of this page preview and they'll be positioned exactly the same way when you actually print or export the plan.
The frame editor mode allows using all kinds of objects and editing them like on a regular plan layer.

50



Figure 4.45 Close print-frames

Once you're done editing the frame, you click one of the red X icons or press the Escape key to go back to close the frame
editor view. Anytime you need to edit the frame again, use the plan toolbar or print region frame icon. Alternatively, right-click
on the print region icon and select Edit print frame.
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4.6.4.3 In-place print preview

File > Print > Print Preview is one way of checking how your frame fits together with your plan content on the printout page,
but RapidPlan is also able to overlay the print preview directly over the plan you're editing. To enable the in-place print preview,
double click the icon located in the bottom right corner of the print region or right click on the print region icon and select In-
place print preview.

Figure 4.46 Double click for print preview

The in-place preview is a great choice if you need to adjust the positioning of your TCP elements so they aren't obscured by the
frame. In fact, you can even move or resize the whole print region and the preview will automatically adjust as required,
allowing you to to quickly select areas you want to print (note that while the print region decoration displays smaller icons in
preview mode, to prevent cluttering, it is still active and you can use its resize handles). On plans with multiple print regions,
only one preview can be active at the same time, but you can easily toggle between regions by double clicking on their in-place
preview icons. To close the preview, use red X icon or the Escape key.
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Figure 4.47 In-place print preview

Note: even if your plan or print region doesn't have a print frame, you can still use the in-place print preview to see how your
print region will be laid out on the printout page.

4.6.4.4 Anchoring frame objects

Anchoring objects to frame edges can be used to ensure they're always positioned the same way with respect to the page
border, regardless of the current page size and orientation. This makes your frames more flexible as they'll automatically adjust
to any printout dimensions. To anchor an object, select it and double-click on one of the 8 anchor points represented by blue
triangles. This will automatically move the object towards the anchor point. If you prefer to create the anchor without moving
the object, hold the CTRL while double-clicking. In either case, the object's offset from the anchor point will be preserved when
the page size changes.

Figure 4.48 Double click to anchor

You can also right-click on the anchor point to see the available options.
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Figure 4.49 Right click anchor menu

Going back to the full print frame example presented above, let's anchor each object to the closest page corner and check how
changing page size and orientation affects the page preview. As you can see in Figure 4.50, the frame contents are still
positioned against the corners even after we change the page size.

Figure 4.50 Anchor example

It is sometimes desirable that the frame rotates its objects when page orientation changes, for example when the plan is using a
single frame but has multiple print regions of different orientations. Frame rotation can be done manually with the button
located on the Print Frame Editor panel, or by selecting an Auto-rotation mode from the frame Properties.
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Figure 4.51 Rotate frame elements

4.6.4.5 Saving and loading frames

Frames you create for specific plans and print regions are saved together with the plan. The print frame editor additionally
allows saving frame contents to separate .tcpf files, so they can be reused on other plans. If you have one or more standard sets
of annotations you use for your TCP documents, paste each of them on a print frame and save the frames to separate files.
Then anytime you create a new plan, you can load the appropriate pre-saved frame file and only upload the plan-specific details
like job location or permit number.

Figure 4.52 Save frame to file

Figure 4.53 Load frame from file
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4.6.4.6 Setting a default frame

If you're using a single frame template for most of your TCP documents, you can make it the default frame, which means it will
automatically be used when printing/exporting diagrams that don't specify their own frames. Save your frame as a .tcpf file,
then go to File > Print > Print Options and click Edit default print frame settings. This expands a panel letting you browse
for the pre-saved frame file. Check the Use as default print frame box and the frame contents should appear on the Print
Preview. Click Save to close the options dialog.

Figure 4.54 Setting a default frame
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4.6.4.7 Overriding print options

By default, when printing or exporting TCPs RapidPlan uses the application-wide settings specified in the File > Print > Print
Options dialog. However, when creating a print frame it is possible to make it override the default settings and use its own
options (for example when a specific print region should be printed to a different paper size). While editing a print frame, go to
its Properties palette, change Print options to Custom, then click Edit. This will open a print options dialog that lets you
specify settings to be used when printing the current plan or region only (depending on whether your frame is defined for the
plan or region).

Figure 4.55 Overriding print options
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4.7 Flip, Alignment and Spacing Toolbars

4.7.1 Flip Toolbar
The flip toolbar allows you to flip selected objects, signs, roads, etc., either vertically or horizontally. You can also rotate these
objects after selecting them by hitting CTRL + R on your keyboard (see Flipping Objects in Chapter 5 for more information).

Figure 4.56 The Flip Toolbar

4.7.2 Alignment Toolbar
This toolbar allows you to align boundaries of selected objects, signs, roads, etc. This toolbar only becomes visible when more
than one object is selected.

Figure 4.57 The Alignment Toolbar
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4.7.3 Spacing Toolbar
The spacing toolbar allows you to distribute any selected objects horizontally or vertically. This toolbar only becomes visible
when multiple objects (three and more) are selected and encapsulated.

Figure 4.58 Spacing Toolbar
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Chapter 5 RapidPlan Basics
Master the basics first!

A solid understanding of the RapidPlan basics will help you get the absolute most out of the program. Understanding how to
correctly interact with and manipulate the plan objects is essential. All too often users make plan creation unnecessarily difficult
by not mastering the basic skills.

5.1 Selecting Objects
Before you can manipulate the properties of your objects (such as the size, shape, position or rotation) you must first tell
RapidPlan which item or items you want to change. You do this, by selecting your desired object(s). Sometimes you will need to
select only one object, as would be the case when you want to change the size of a single sign. On other occasions you will
need to select multiple items, like when you need to move and group objects at the same time. The two cases are handled
slightly differently.

5.1.1 Selecting Single Objects
There are two ways to select a single item in RapidPlan:

By clicking on it.
By dragging a selection box around it (this can also be used for selecting multiple items as specified at the end of the
previous chapter).

5.1.1.1 Select by Clicking

Simply click once on your desired object and it will become selected. You will notice a number of new controls are displayed.

Figure 5.1 Selected sign

60



5.1.1.2 Selecting objects on different layers

If you are working across multiple layers, you can switch between different objects on the fly by holding down the CTRL + ALT
keys and clicking on desired objects in a different layer. This will switch to the layer on which the object is on, as shown in
Figure 5.2 below

Figure 5.2 Selecting objects on other layers
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5.1.1.3 Select with a Selection Box

The other way to select an object is by dragging a selection box around it. Simply click outside the bounds of your object, and
drag the selection box out until it completely encompasses it. Release the mouse, and your object will be selected.

Figure 5.3 Dragging Selection Box around object with left mouse button

Note: The selection box will only capture items that are completely surrounded by the selection box. However, if you hold right
mouse button whilst dragging the selection box over the objects, it will select all of the objects in the selection box, even if
partially covered.

Figure 5.4 Dragging Selection box with right mouse button

5.1.1.4 Selection preview

Any objects that have been highlighted in the selection box will be highlighted in green, indicating what you have selected.
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Figure 5.5 Selection Preview Box

The below are the available selection modes when selecting objects:

Selection modes

New selection (default)

Add to selection (hold Shift key)

Remove from selection (hold Alt key)

Capture modes

Contained objects (default)

Intersecting objects (use right mouse button)
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5.1.2 Selecting Multiple Objects
Selecting multiple objects is useful when you want to move, duplicate, cut or copy more than one element on a plan. You will
also need to select multiple objects if you wish to group a collection of items together (see section 5.2.7 Grouping Objects).

Again, there are two ways to perform a multiple selection:

By dragging a selection box around all of the elements (as described above).
By holding SHIFT and repeatedly clicking on each element that you wish to select.

Figure 5.6 Multiple objects selected with SHIFT key
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5.2 Features Accessed by Selecting an Object
Once you have selected your object, a number of new tools become available. Its important that you understand what each tool
does as you will come to rely upon them heavily.

Object Features

Bounding Box 
The bounding box shows you exactly which objects you have selected. In this example there is only one selected
object - the Give Way sign.

Resize Handles 
The resize handles allow you to stretch or shrink the selected object. When selected, every object will have eight
resize handles; three at the top, three at the bottom, and two on the lateral sides of the bounding box. Note that
when the cursor hovers over a resize handle, the handle turns red and the cursor becomes a cross.

Rotation Handles 
Click and drag a rotation handle to "free rotate" an item. This example has four rotation handles - an arrow in
each corner of the bounding box. Note, again, when the cursor hovers over a rotation handle, the handle turns
red and the cursor becomes a cross. Drag the handle in any direction to rotate an item.

Move Handle 
To move an item, simply hover over it with your mouse and drag it anywhere around your canvas. The cursor
will change to a hand pointer when you hover over an item.

Control Points 
Control points are special handles which allow you to alter the shape of an object. Many objects and road tools
have control points and allow for the insertion of multiple control points anywhere along an item. This example
has six control points.

Table 5.1 Features Accessed by Selecting an Object
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5.2.1 Understanding Object Properties
An important feature accessed through selecting an object is editing the object's properties. Every single object in RapidPlan
has a set of properties which determine how that object appears on the canvas. The available properties will vary from object
to object. The table below contains a few examples of different objects and some of their properties:

Object Tools
type Example properties

Ellipse, Rectangle, Polygon, Rounded
rectangle,
Filled Bezier, Filled spline

Shapes
Stroke - width, color, style, cap 
Fill - opacity, color, style 
Tension

Delineator tool Devices Positioning - spacing, alignment, geometry style 
Delineators - type, size

Road tool Roads

Measurements - units 
Road - auto merge, color, geometry style 
Lanes - count, width, markings 
Lane Markings - width, color, style, dash and gap lengths 
Shoulders - show left, show right, left shoulder width, right
shoulder width 
Side-walks - show left, show right, left width, right width, left
offset, right offset 
Distance Markers - spacing, show

Table 5.2 Object properties

Each object is drawn with it's default properties set, but you will undoubtedly want to frequently change an object's properties.
Fortunately, this is very simple. Default preferences can be changed by clicking on Tools > Preferences.

5.2.1.1 View or Edit an Object's Properties

1. As discussed previously, you can edit properties from the properties palette or using quick edit mode. Double click on the
object you wish to inspect to open the Quick Edit box. The object's properties screen will appear. Note that the properties
will be different for each object type.

Figure 5.7 Quick Edit screen

2. Make any necessary adjustments to the settings.

3. The Preview window will show you any adjustments you've made. Press Ok to complete your changes.
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5.2.2 Moving Objects
Of course there will be times when you will need to move a placed object on the RapidPlan canvas. This is accomplished using
the move handle.

To move one or more objects on the plan:

Select the item or items that you wish to move.
Click and drag your selected object (if you have more than one object selected, you can use any of the move handles that
are showing).
For fine placement, you can use the cursor keys on the keyboard to nudge your selection into place.
For larger nudging steps, hold SHIFT key in combination with cursor keys.

5.2.3 Rotating Objects
Frequently it will be necessary to rotate an item on a plan. There are three methods of rotation:

Free rotate with the rotation handle.

Right clicking an object/tool and select Transform > Rotate clockwise, Rotate counter-clockwise, Rotate upside
down or custom Rotate by degrees options.

On selected object, right click on Rotation Handles (curved arrows) on corners (see Figure 5.8).

Hit CTRL + R when an object is selected and it will rotate in 90 degrees increments.

Micro rotate clockwise with CTRL + ALT + R or counter-clockwise with CTRL + ALT + E.

Figure 5.8 Rotate selected object

Note: You can rotate one or more selected objects at the time.
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5.2.4 Control Points
Almost every element in RapidPlan has at least one control point. A control point is a handle that allows you to alter the shape
of an object. They appear in RapidPlan as small red circles. Control points do different things to different kinds of objects, and
different objects have different numbers of control points.

The control points along the road enable you to adjust its shape.

Figure 5.9 Control Points
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Callout boxes have two control points - one to position the head and one for the tail.

Figure 5.10 Callout Box Control Points

To view an object's control points you must select it. Once you have selected an object, you can move its control points around
to change the shape and of the object.

5.2.4.1 Keeping Control Points Straight

Irrespective of what item you are drawing or altering, you can keep your control points in a perfectly straight line by holding
down the SHIFT key as you are drawing. The same applies if you are moving an existing control point.

This technique is especially helpful when drawing straight roadways.

5.2.4.2 Adding/Deleting a Control Point

You can add a control point to an object, for example if you want to add a curve to a train track, by selecting the object, right
clicking and selecting Insert Control Point.

Note: This option will only appear for objects that can utilize extra control points.

Similarly, you can remove control points by selecting the object, right clicking and selecting Remove Control Point.
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5.2.4.3 Control Point Snapping

Once you have selected an object and can view its control points, you can seamlessly connect objects to one another by
snapping into existing control points. Hold the CTRL key while point-snapping roads/work areas or other objects and their
geometries will merge.

This feature will help you to create a neat and straight-lined work area.

Tip: If you want to snap control points across multiple layers/stages, hold Ctrl+Alt while drawing or transforming objects. This
is particularly useful when drawing complex plans with multiple stages, as it allows hassle free snapping to base stage objects
like road lanes and edges.

Figure 5.11 Snapping between control points

Note: You can also snap points and align drawn segments not only at control points, but anywhere along a snap geometry as
shown in Figure 5.12 below.

Figure 5.12 Snap along geometry

5.2.4.3.1 Advanced snapping

For additional snapping options, press the Alt key while snapping to a geometry to enable guides for tangent and perpendicular
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lines as well as geometry midpoints.

Figure 5.13 Advanced snapping

5.2.4.4 Drawing along geometries

Snap to an existing geometry when drawing an object and RapidPlan will automatically create control points to fit the desired
curve.

This is useful when needing to draw delineation devices or a work area along a curved geometry.

To being drawing along a geometry, simply left click your device along the red geometry where you want the device to begin.
The tool will then follow the curve you draw out, as seen in Figure 5.11 below.
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Figure 5.14 Geometry snapping

While drawing an object you can snap its segments to different geometries as well. This can be done by snapping points to
existing geometries and tracing the drawing along it, as seen in Figure 5.12 below.

Figure 5.15 Geometry lines
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5.2.4.5 Offsetting the geometry

Use the Offset Geometry tool to further adjust the position of an object.

To utilize the offset tool, simply complete your drawing along the geometry, once completed, right click and select 'Offset
geometry' in the right click menu displayed (shown below).

Figure 5.16 Offset geometry

Simply click and drag to your desired offset, or type your desired offset value in the offset dialogue box, as shown below.
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Figure 5.17 Create offset

Once the offset has been created, right click to save your changes.

5.2.5 Resizing Objects
There will almost always be two different ways of resizing an object in RapidPlan. It is important to understand the difference
between the two methods, and when to use each.

5.2.5.1 Resizing using Control Points

Most of the RapidPlan objects can be resized by moving their control points. Moving the control points changes the shape of
the object, rather than just stretching or shrinking it.

To resize with control points:

Select the item you wish to resize.

Drag its control points until the object is the size and shape you require.
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Figure 5.18 Control Point resize

Note: The cursor has changed as it hovers over the control point. This means it is ready to move the control point.

5.2.5.2 Resizing with the Resize Handles

You can also change the size of your object with the resize handles. Unlike the control points which change the shape of the
object, the resizing handles stretch and shrink your selection.

To resize with the resize handles:

Select the item you wish to resize.

Drag either of the resize handles to stretch or shrink the object. (If you hold SHIFT while you resize, the length to width
ratio of your object will be maintained).

Figure 5.19 Resize Handles rail

Note: The cursor has changed as it hovers over the resize handle. This means it is ready to move the handle.

5.2.5.3 Resizing with the Skew handles

Create pseudo perspective views by holding Ctrl+Alt to turn object scale handles into skew handles.
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When you have your sign/object selected, simply hold the Ctrl+Alt keys to activate the skew handles. You can then adjust the
skew of the object with these keys held down, as you can see in Figure 5.15 below.

Figure 5.20 Skew handles

5.2.5.4 Comparing the Two Methods

It is critically important to understand the distinction between resizing using control points and resize handles so we have
compared the two methods below.

Below is three sections of rail line. Section A is the original piece (5 sleepers). Section B has had its control points moved,
lengthening it and adding sleepers (11 sleepers). Section C is the original piece, resized using the resize handles. Notice that C
still has the same number of sleepers (5) but is much larger. The resize handles have effectively rescaled the section of track.

Figure 5.21 Resizing Control Points vs Resize Handles
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5.2.5.5 Flipping Objects
As well as rotating objects, you can also flip them either horizontally or vertically using the flip buttons on the Flip toolbar. Note
however, that the flip buttons are only ever visible when an object which can be flipped is selected. (Users of other drawing
programs will recognize flipping as being equivalent to reflecting in the X or Y axes).

Figure 5.22 The Flip Tools are visible because the Arrowboard is selected
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5.2.5.6 Grouping Objects
One of the most important techniques to master is grouping. By grouping objects together, you can manipulate them as one
item. Grouping is also necessary if you wish to create and save your own signs. You can group any of the RapidPlan elements
together and the technique is the same, regardless of which elements you choose to group.

5.2.7.1 To Create a Group

There are two ways to group objects

1. Using the Grouping Toolbar:

Select All - selects all of the objects on your plan

Group - groups your selected objects together

Ungroup - ungroups the grouped objects

Figure 5.23 Grouping Objects using the Toolbar

Note: The individual bounding boxes and move handles are replaced by just one for the entire group.

2. Using your mouse or keyboard:

Select the objects you want to group together (by pressing SHIFT and selecting each desired object individually or by
dragging your mouse encompassing all of the desired objects).
Right click and select Group objects from context menu
Or hold CTRL + G.
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5.2.7.2 To Ungroup a Group

Select the necessary group.
Either right click on the group and select Ungroup Objects, use the Ungroup icon in the toolbar or use the shortcut key
CTRL + U.

Figure 5.24 Ungroup Objects by Right Click

Note: Grouped objects can edited without ungrouping. Double click on the group item to launch the quick edit box - you will
then have the option to change the properties of a particular object in the group.

5.2.7.3 Signs are just Groups too...

Every sign in RapidPlan is made of a group of primitive objects - the most simple of which consist purely of a colored rectangle
or square with text. These can be edited using the techniques shown above to create new signs.

See Chapter 12 for more information on modifying and creating your own signs.

5.2.8 Snap to Bounds selection
When moving or scaling objects and print regions, their bounds edges and centers snap to each other for quick and precise
positioning.

This can be particularly useful when trying to align objects to Print region borders or when creating custom signs, see Figure
5.17 below

The bound edges or centers will be indicated by a red dotted line.

NOTE: Use F3 to quickly toggle snapping on/off.
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Figure 5.25 Snap to bounds
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5.3 Duplicating Objects and Styles
RapidPlan has made it simple to duplicate objects and/or an items property onto another item.

Figure 5.26 Duplicate Object and Duplicate Style

5.3.1 To Duplicate an Object
Right click on the desired object to duplicate.
Hover cursor over Duplicate in the contents menu.
Select Object.
Click to place as many duplicated objects as needed.
or Keyboard shortcut: CTRL + D

5.3.2 To Duplicate an Object Style
Right click on the desired object to duplicate it's style.
Hover cursor over Duplicate in the contents menu.
Select Style.
Draw object with the duplicated style.
or Keyboard shortcut: CTRL + SHIFT + D

5.3.2.1 Duplicating Styles onto Other Items

As shown in Figure 5.26, you can paste the style/properties of one item onto other items. This can be useful when, for example,
you have different road tools in use (eg. road, roundabout, arc road) and you want to give them all the same style/properties.

To duplicate a style onto a different item:

Select the item to duplicate style.
Press CTRL + C
Now select item to transfer the style onto it.
Press CTRL + SHIFT + V
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5.4 Cropping objects
Crop images and other objects to any desired shape, edit individual points and segments in existing crop geometries.

To begin cropping an object, simply right click on the object you wish to crop, then left select "Edit crop".

Figure 5.27 Edit crop

This will then display a dialog box that allows you to change your crop mode. You can select between: Rectangular region,
which allows you to select and crop a rectangular region; or Polygon region, which allows you to add multiple control points
to create the crop shape.
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Figure 5.28 Crop box

Once the desired crop region has been added, click the green tick button in the dialog box to apply the cropping.

Note: The crop object size/shape can be adjusted at any time by moving it's green control points.

Figure 5.29 Cropped image

To edit the cropped region, simply select the object, right click, select 'Edit crop' and the dialog box will re-open. You can now
adjust the crop region or revert back to the original image.
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Figure 5.30 Finished crop
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Chapter 6 The Road Tool
The very core of RapidPlan...

The road tool lies at the very heart of RapidPlan. In the vast majority of cases, you will use the road tool to create the base of
your plan. Whilst it's not difficult to use, there are some tricks and traps if you don't fully understand how it works. By
understanding how to use the road tool properly, you will save yourself enormous amounts of time.

6.1 Components of the RapidPlan Road
The road has a number of different parts. It is well worth familiarizing yourself with them.

Figure 6.1 Road components

6.2 Basic Drawing Techniques
Drawing using the road tool is very simple. As you move the mouse after you have clicked to start drawing, the roadway will
"snake" behind the cursor. Each time you click the mouse on the canvas, a new turning point for the road is placed. The turning
point is represented by a control point.

6.2.1 To Draw a Road
Select the Road from the Tools palette.
Move your mouse to the canvas and click once to start drawing your road.
Move the mouse around the canvas, clicking at each turning point.
When you have placed your final point, right click to stop drawing.
If you don't want to draw another road, right click again to drop the road tool.

6.2.2 Keeping Sections Straight
A simple trick allows you to draw perfectly straight roads. By holding SHIFT, RapidPlan will make sure that each control point is
placed in a perfectly straight line.
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6.2.3 Setting the Number of Lanes on the Carriageway
There are two simple ways to add and remove lanes to roadways:

1. Double click on the road to be altered to bring up the Quick Edit screen
2. Select the object and change the number of lanes from the Properties palette within the right pane.

Figure 6.2 Road Properties Lanes
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6.2.4 Editing the Shape of an Existing Road
Like any other object in RapidPlan, the shape of the road once drawn can very easily be edited by shifting it's control points.

To edit the roads shape:

Select the road by clicking on it once. This will make its control points visible.
Drag any of the control points until the road is the correct shape.
Remember that you can hold SHIFT to make the control points line up in a row.

In the image below, Road A is the original road. Road B has had the 2nd and 3rd control points adjusted to change the shape of
the road.

Figure 6.3 Road Control Points
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6.2.5 Adding and Removing Control Points
There will almost certainly be circumstances where you need to add or remove a control point from a road to fine tune its
shape.

Adding control points allows you to create extra turn points to your road, hence extra curves.

To add a control point:

Select the road by clicking on it once.

Right click where you want to add the control point, and select Insert Control Point from the context menu.

Figure 6.4 Adding a Control Point

Removing control points is equally simple as adding them. You do need to remember that you can only delete end control
points if there is at least one control point in between. That is to say, that there must be at least two control points on every
road.
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To remove a control point:

Select the road by clicking on it.

Right click on the desired control point and select Remove Control Point from the context menu.

Figure 6.5 Removing a Control Point
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6.2.6 Inserting Road Ends
There will be occasions where you need to insert a road end or a dead-end road. To do this we simply make a road and change
its properties as seen in Figure 6.6.

Figure 6.6 Types of road ends

You can select from flat, round or cul-de-sac. You can adjust sizing and control point of inserted road end.

6.2.7 Using the road width handles

There will be times when you need to adjust road, sidewalk or shoulder widths. Rather than going to the road properties you
can adjust them on the road itself.

To enable the handles, simply select a road and hold CTRL + H. This will bring up adjustable road width handles as seen in
Figure 6.7

Figure 6.7 Turning on road width handles
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6.3 Properties of the Road Tool
Of all the tools in RapidPlan, the Road has by far the most power and flexibility. Accordingly, there are a great many settings
you can alter to set your road up as you require. You can change:

Road color, geometry and auto merge
Lane number, width, color and lane markings
Left side/right side edge line, shoulder and sidewalk widths and colors
Distance markers
Legend and manifest preferences

All of the above settings are accessed through the road properties screen. You can access the properties screen by double
clicking on the road you need to change from the Quick Edit mode or from the Properties palette.
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6.3.1 Road
The Road section of the road's properties allows you to adjust the color, the road geometry (Spline, Line or Bezier) and auto
merge preferences.

To change the color of the road in the properties palette:

Select the road on your plan

Select the Road section on the properties palette

Select the Color bar (the blue bar in Figure 6.8)

Some color options will become available for you to choose from

Figure 6.8 Road Properties

The auto merge feature controls whether a new road will automatically merge with the selected road. As shown below, when
set to True it means the new road will automatically merge, False means it will not.

Figure 6.9 Road Auto Merge ON-OFF
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6.3.2 Lanes
In this section you can edit the number of lanes, lane width and lane markings (including width color and style).

Figure 6.10 Lane Properties

To change a road's lane markings in properties:

Select the road.
On the Lanes tab in the properties palette select Markings.
Change the width value, the color and/or style of the markings (Dashed, Solid, DashSolid, SolidDash, Double or None),
dash and gap length.

Styles of Lane Markings for your roads:

Figure 6.11 Lane Marking Styles

Each line marking on a road is set individually, so you can have different markings for different lanes. Each extra lane you add
will accessible in the Markings section.
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6.3.3 Left Side/Right Side of the Road
By default, each road is drawn with both a left and right edge line shoulder and sidewalk. You can set the width of the shoulders
and sidewalks, or choose to turn them off completely. The left and right sides can be configured individually, and as such do not
need to be the same in appearance.

Figure 6.12 Left and Right Side Road Properties

In this section you can adjust the left/right edges (color, width), shoulders (width, color, shoulder edge) and sidewalks (width,
color, offset).

To change Left Side (or Right Side) shoulder properties:

Select the road.

On the Left Side/Right Side section of the properties palette select Shoulder to adjust the width and color of the Left
Shoulder (see Figure 6.13).

Note: The Edges and Sidewalks can be adjusted in a similar way.
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Figure 6.13 Left Side Shoulder Width has been increased and Left Sidewalk changed to Green

To turn a edge/shoulder/sidewalk on or off:

Select the road.

On the Left Side/Right Side section use the check boxes to toggle the on/off state of the properties as shown in Figure 6.14.

Figure 6.14 Shoulder and Sidewalk turned off
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6.3.4 Distance Markers
This section allows you to activate distance markers on the road. On the Figure 6.15, you can see the distance markers have
been set to True and are visible on the road, also font color changed to black.

To activate Distance Markers on a road:

Select the road.

On the Distance Markers section of the properties palette click False in the Show section to change it to True.

Figure 6.15 Activated Distance Markers on a road
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6.3.5 Legend and Manifest
By default, roads are not included in Legend and Manifest. To change this you to activate the road object on a Legend &
Manifest section.

There you can also choose the manifest value as Default or Dimensions and set custom Entry name (see Figure 6.17)

To activate road on your plan's legend and/or manifest:

Select object.

On the Legend & Manifest section of the properties palette clock on False on Show in legend section to make it True.

Figure 6.16 Legend and Manifest Properties

Figure 6.17 Custom Entry name and Manifest value
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6.3.6 Setting a Default Road Style
Some users with special needs will not want their roads drawn in the factory default format. Therefore, you can configure a
different default road style. You can set a default for any or all of the properties described above.

To set the road defaults:

From the Properties palette, select all of the properties settings to the desired default settings you would like.

At the base of the palette select the Save object style > Save as default style or Save as new style.

Figure 6.18 Save object style

Figure 6.19 Save as new style window

6.3.7 Dimension Input Panel*

Start typing at any time while drawing objects to specify precise distance, angle, offset, point or coordinates for the next point.
Pixels or site distance units can be used (for plans drawn to scale).
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Simply click out the first point of your distance marker, start typing your measurement and the dimension input panel will
display, hit enter and it will give you an exact measurement based on your input. Then hit enter again to confirm the
measurement

Figure 6.20 Using the dimension input panel
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6.4 Creating Intersections
The real power of RapidPlan lies in its ability to quickly create intersections. They are formed by "adding" new roads to existing
ones. RapidPlan will automatically remove edge lines, shoulders, and sidewalks to blend at the intersecting point where a road
is overlapping another road.

To form an intersection:

Select the Road tool from the Road Tools tab.

Draw your first road.

Now draw a second road overlapping the first road.

Figure 6.21 Two Roads Overlapping Creating an Intersection

Once the added road is in place, it can be modified like any other.

See Chapter 8 for Advanced Intersections.
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Chapter 7 Other Road Tools
7.1 More Road Creation Tools
Often, the road tool alone will be all you need to create your roadway. Other times you will need some extra pieces to make
your road look the way it should. RapidPlan has many more tools which compliment the road tool and allow you more options
in your plan creation. They can be found in the Roads tab of the Tools Palette.

7.1.1 The Turn Lane Tool
This tool is used for making a slip lane or a turning lane.

To create a turning lane:

Select the Turn Lane tool from the Roads tab in the Tools Palette

Assuming you are adding this to a pre-existing road, click on the road where you want the turning to start

Click again around the middle of the turning lane to place a control point

Place your final click where you want your turning lane to end

Right click to drop the tool

Figure 7.1 Turning Lane on left and a Slip Lane on right using the Turn Lane tool
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7.1.2 The Road Arc Tool
This tool allows you to create a precise arc in a road with ease. As you can see in Figure 7.2 and Figure 7.3, it is created from a
radius.

To create a Road Arc:

Select the Arc Road tool in the Roads tab of the Tools palette

Click once to set the radius of the road arc

The second click is where you start drawing your road arc from

Now drag your cursor in the direction you want the road

Click to place the road

Right click to drop the tool

Figure 7.2 Arc Road
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You can also choose to set the arc's radius, angle and direction manually in the Arc tab of the Properties Palette.

Figure 7.3 Arc Road Properties
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7.1.3 The Roundabout Tool
The Roundabout tool is relatively simple to use and blends easily like other road tools.

To Create a Roundabout:

Select the Roundabout tool in the Roads tab of the Tools palette

Click once to place the roundabout, this is going to be a center of your roundabout

Shift your mouse up or down to make the roundabout bigger or smaller

Right click to finish

Figure 7.4 Roundabout
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7.1.4 The Road Corner Tool
This tool allows you to easily create road corners for your roads. It is controlled by three control points to assist in the shape
and positioning of the object and a single shape point that controls the shape of the curve.

To create a road corner:

Select the Road Corner tool from the Roads tab in the Tools Palette
Place your first click where you want your corner to begin
The second click places the inner corner of the object
The third click places the final corner
The final click positions the shape point.
As mentioned, there are three control points and shape point to help you adjust the object

Figure 7.5 The Road Corner Tool

105



7.1.5 The Road Region tool
The Road Region tool is free form road tool which you can use to draw irregular paved surfaces, like parking lots.

To create a road region:

Select Road Region tool from Roads tab in the Tools Palette.
Start your region at the smallest corner and click once to start drawing.
Move in either a clockwise, or anti-clockwise order, clicking at each of your region's corner points (Note: Remember, you
can hold SHIFT to keep the corners of your region perfectly straight).
When you have placed your last point, right click to stop drawing, and then right click to drop the Road Region tool.

Figure 7.6 Road Region Tool
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7.2 Road Marking Tools
These road masking and marking tools are necessary if you need to remove and/or change lane markings on the road. All of
these tools can be found in the Markings tab of the Tools Palette.

7.2.1 The Lane Mask tool
Sometimes, it may be necessary to remove a small section of a lane marking on a road. This is often the case when building
intersections. You can remove a small section of lane marking by using the Lane Mask tool. It's located within the Tools palette
in the Markings tab.

To mask out a lane marking:

Hover your cursor over Markings in the Tools palette

Select the Lane Mask tool

Click and hold the left mouse button on the marking, at the point you wish to start the mask

Move the mouse along the line to lay out the mask

On curves, you will need to click in turn points for your mask as it follows the road

Right click to finish

Figure 7.7 Lane Masking tool

The lane mask tool is no different to any other object in RapidPlan once it's been placed, you can select it and shift its control
points if you didn't manage to completely cover the line in the first attempt.
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7.2.2 The Road Mask Tool
This tool operates similar to the Lane Mask tool and removes sections of lane markers but instead of covering only a lane
width, you can cover an entire road to remove markers. This comes in handy particularly when you have several lanes on roads
that meet at an intersecting point and you need to remove many lane markers.

To mask out lane markings using the Road Mask Tool:

Hover your cursor over Markings in the Tools palette.

Select the Road Mask tool.

Start using the tool as you would use the Polygon tool drawing a perimeter of the road mask enclosing all the lane
markers you want.

Right click to finish.

Figure 7.8 Road Mask tool
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Again, there are control points and resize handles to allow you to adjust the shape and size of the road mask.

Figure 7.9 The difference between the Lane Mask and Road Mask tools

7.2.3 The Lane Marker tool
The automatic lane markings on the road always perfectly follow the curve of the road. Sometimes you will need to create
something different, so RapidPlan has a custom lane marker tool. In a lot of cases, you will use the Lane Marker tool in
conjunction with the lane mask tool. The example below will show you how to combine the two.

In this example we will replace the current dash lane marker with the solid double line lane marker.

Firstly, we need to remove part of the existing lines. We do this with the lane mask tool (see section 7.2.1 The Lane Mask tool).

Next we select the lane marker tool and draw in the edge merge the line.

To create a new lane marking:

Hover your cursor over Markings in the Tools palette.

Select the Lane Marker tool.

Click once on your road where you want to start.

Move the mouse, clicking to place turn points as required.

When you are finished, right click to stop drawing.

Right click again to clear the cursor.
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Figure 7.10 Using a Lane Marker

You can change the lane marker to any of the standard lane styles (Dashed, Solid, SolidDash, DashSolid and Double) or change
its color by accessing its properties screen (see section 6.3.2 Lanes). You can also set Lane Marker Defaults the same way you
set the Road Defaults as specified in section 6.3.6 Setting a Default Road Style.

To change the properties of a lane marking:

Double click on the lane marking
On its properties screen, make any required alterations to the type and color of the line
Click Ok to accept the changes
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7.2.4 The Flush Median Tool
This tool works like any Polygon where you click to place each of its corners and can adjust the control points to get the shape
you need.

Figure 7.11 A Flush Median tool

7.2.5 The Chevron Flush Median Tool
This tool also works like a polygon, with the first click forming the tip of the chevron.

To place the chevron flush median tool:

Select the Chevron Flush Median tool from the Markings tab in the Tools Palette

Your first click will be the top point of the shape (in the direction of the chevron)

Then click for all other consecutive points

Right click to finish

Figure 7.12 Chevron Flush Median tool
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7.2.6 Marked Path Tool
By using the marked path tool you can outline the way a direction of traffic will flow in a clear and easy to read visual.

Figure 7.13 Marked path tool

The tool works like any of the other road, line tools, etc., just click to mark each turning point of the arrows to make out
direction of traffic as seen in Figure 7.14.

Figure 7.14 Marked path tool example
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7.3 Road Infrastructure Tools
These tools enable you to add infrastructure to your road plans. They can be found in the Infrastructure tab of the Tools
Palette.

7.3.1 The Train Tracks
The Train Tracks tool allows you to quickly add train or tram (light rail) lines to your plan.

To place a train line:

Select the Train Tracks tool from the Infrastructure tab in the Tools Palette

Click once to start your rail line.

Click at each turn point.

Right click to stop drawing.

Figure 7.15 Train Tracks and Tram Tracks
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To place a tram line on Properties palette change Type value from Train to Tram

Figure 7.16 Train Tracks tool types
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7.3.2 The Crosswalk
The Crosswalk tool is a handy tool that creates crosswalks on roads, arcs, and roundabouts. There are a few options available
when editing the crosswalk. You can change the crosswalk width and type to parallel or hatched. The stripe width and spacing
can also be changed to accommodate your specifications.

To create a crosswalk:

Draw your road

Select the Crosswalk tool from the Infrastructure tab in the Tools palette

Place your cursor where you want the crosswalk to start and left click your mouse once to start drawing

Right click to finish drawing

Figure 7.17 Crosswalks

Three different types of crosswalks have been created in the screen print above. Crosswalk type can be changed on the
Properties palette.
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7.3.3 Traffic Islands
Learning how to create traffic islands/refuge points and center medians is important. There are two tools that you can use in
RapidPlan to create them - the Polygon tool and the island tool.

7.3.3.1 Islands with the Polygon

Creating islands with the polygon is as simple as tracing out the shape of your island on your road. This is the easier of the two
methods.

To create an island with the polygon:

Select the Polygon tool from the Shapes tab in the tools palette

It is best to start your island at one of its corners. Click once to start drawing

Move in either a clockwise, or anti-clockwise order, clicking at each of your island's corner points (Note: Remember, you
can hold SHIFT to keep the corners of your island perfectly straight)

When you have placed your last point, right click to stop drawing, and then right click to drop the Polygon tool

Figure 7.18 Creating an Island with a Polygon

The picture above shows an example of a click sequence to create an island. Polygon is a free form tool, you can make islands
of virtually any shape.

7.3.3.2 Islands with the Island Tool

In many aspects, creating islands with the Island Tool is the same as using the polygon. This is because the Island Tool is just a
special kind of polygon. The difference between the two is that the Island has shoulders that match the road.

This is definitely an advanced tool and will take some practice to master.
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To create an island with the island tool:

Select the Island tool from the Infrastructure tab in the tools palette

Start your island at the smallest corner, click once to start drawing

Move in either a clockwise, or anti-clockwise order, clicking at each of your island's corner points (Note: Remember, you
can hold SHIFT to keep the corners of your island perfectly straight)

When you have placed your last point, right click to stop drawing, and then right click to drop the Island tool

Figure 7.19 The Island Tool verses Polygon Tool

There are two main differences between using the polygon and Island tool:

1. A different start point - Unlike the polygon, you should never start your island on a steep corner point (anything greater
than about 45 degrees). This is because it can cause the shoulder lines to cross over.

2. The Island Tool can be curved - By using a special technique, the control points for the island can curved, allowing you to
make perfectly accurate reproductions of what is actually on the road.

The technique for creating control points is simple but requires some practice.

To create a curved island:

Draw your island as normal

Ensure your cursor is clear of the Island Tool by right clicking

Now select the Island that you've drawn by clicking on it once

Move your cursor over the control point that you wish to curve and hold down the CTRL button on the keyboard. The
control points will then turn from red to blue and display curve handles
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Drag the curve handles out (away from the control point) to increase the radius of the curve until you are happy with the
islands shape

Figure 7.20 Curving Island
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7.3.4 The Bicycle Lane Tool
The Bike Lane tool works similarly to tools like the Polyline and the Road tool. The bike image can be changed from a Standard
(as shown below) to a Shared lane symbol in Properties.

Figure 7.21 Bike Lanes on a Road

To place the bike lane:

Select the Bike Lane tool from the Infrastructure tab in the Tools Palette.
Click to start the bike lane.
Hold SHIFT to create a straight lane, or click to create control points to adjust the lane's shape.
Right click to finish.

7.3.5 The Parking Bay Tool
This tool makes it simple to add parking bays to your plan. In the items Properties Palette you have a selection of Parking styles.
As you can see below, they include sides & corners, full, sides, and corners.

Parking Bay type options Parking Bays along a road

Figure 7.22 Parking Bay Type Options Figure 7.23 Parking Bays along a Road

To place a parking bay:

Select the Parking Bay tool from the Infrastructure tab in the Tools Palette.
Click at the first corner and drag out a line (hold SHIFT to keep straight).
Click again to make the second corner then drag the parking bays out to make their full shape.
Click a third time to complete it, and Right click to finish.
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7.3.6 The Sidewalk Tool
The Sidewalk tool is used like any Polyline tool. In the example below, you can see that the Road tool's sidewalk and the
Sidewalk tool's sidewalk are visually the same, however, you have more control over the Sidewalk tool as it is an individual
item, such as putting a sidewalk through a grassy patch like in the example below.

Figure 7.24 The Sidewalk Tool vs the Road Tool Sidewalk

7.4 The Intersection Editor
The Intersections Editor tool can be used to create complex intersections with just a few mouse clicks. The editor will assist you
in adding corners, turn lanes, markings, crosswalks and lane symbols, automatically aligning them with underlying roads. Once
created, an intersection remains fully adjustable and editable, or it can be ungrouped for custom adjustments of the individual
elements.

7.4.1 Creating and editing intersections

The Intersection tool is available from the Tools palette, in the Roads category. After selecting the tool, the first click positions
the center of the intersection, then subsequent clicks add roads to the intersection. Once you've placed 3 or more roads, right-
click to finish drawing, right-click again to release the tool, then click on the intersection to select it (TIP: alternatively, double-
click when placing the last road - this will finish the drawing and select your object in one go).

When an intersection object is selected, Control Points are available to adjust the length and position of incoming roads, and
the Intersection Editor panel is displayed - this is where you will be editing intersection elements. To change style of an
incoming road, for example to change the number of lanes, select it in the editor list and its style options will be exposed in the
Properties panel.
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Figure 7.25 Selecting intersection tool

7.4.2 Adding and selecting intersection elements

Note the 4 icons at the top of the Intersection Editor panel - these can be used to switch between the available editor modes:

Road properties - adding and editing incoming roads,

Road extensions - road corners and turn lanes,

Markings - lane markers, stop lines and flush medians,

Symbols - crosswalks and lane symbols.

To add an intersection element, switch to the required category and click one of the add [+] buttons in the panel. This will
decorate the intersection with additional [+] buttons showing places where this type of element can be added. The sample
below shows the process for adding a turn lane:

Figure 7.26 Adding intersection elements

Once an intersection element is added, it appears on the elements list in its category. You can select an intersection element
directly from the list, or by holding the Ctrl+Alt keys and clicking on the required element of the intersection object. The
selected element gets highlighted with a red outline. TIP: to select more than one element hold the Ctrl key when selecting from
the editor list, or Ctrl+Alt+Shift when clicking on the intersection object.
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Figure 7.27 Selecting intersection elements

7.4.3 Editing element and positioning styles

When an element is selected, it displays a draggable Offset point. You can drag the point to position the element along the road
it was added to (Offset = 0 represents the position at which the road meets the other roads forming the intersection). For Turn
Lanes, the point allows adjusting the lane length, and for Road Corners - the corner radius. Some elements (Lane Markers,
Flush Medians) present two points - for adjusting the Offset and the Length of the element.

NOTE: since the Offset value is relative to the intersection, changing the layout of roads forming the intersection will
automatically adjust all intersection elements.

Other than dragging the points, you can also provide specific values for Offset, Length of selected intersection elements in the
Properties panel. The Properties grid also contain some more advanced settings (see the set of properties for a Flush Median
element below), allowing you to draw medians with different transitions and tails. Note the "Edit mode" button - for elements
that have editable styles, clicking it exposes the dedicated style properties instead of positioning ones.

Figure 7.28 Editing element styles

One property that requires an additional comment is Position & size -> Orientation that determines the reference line used
when calculating object position for the current Offset value. The orientation can either be Aligned (with the line connecting the
points where the road meets its left and right neighbors) or Perpendicular (to the road itself). For roads meeting at right angles
these modes will produce identical results, but for some other road layouts it'll be important to understand the difference in
order to achieve the desired positioning, particularly for objects stretching across the road, like the crosswalk or stop lines. The
difference between the two modes is presented below:

Figure 7.29 Line orientation

7.4.4 Ungrouping intersections
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The intersection editor is designed to assist in drawing typical intersections. If any additional adjustments are required for more
complex intersection layouts, an intersection can be ungrouped, allowing all its elements to be freely edited (ungrouped
elements become regular plan objects, exposing adjustable control points and properties). To ungroup, simply select an
intersection and hit Ctrl+U.

Sometimes, instead of ungrouping the whole object, you might want to detach a specific element from the intersection. To
achieve this, select one or more elements, right-click and select Edit intersection elements -> Detach from intersection. This will
remove the elements from the intersection and replace them with identical object added directly to the plan. See an example
below:

Figure 7.30 Ungrouping intersections

7.4.5 Connecting incoming roads

The intersection object exposes control points at the end of each of its roads. These points can be snapped to when drawing a
road object or adjusting control points of an existing road. Holding down the Ctrl key while snapping to intersection enables
automatic road alignment - RapidPlan will automatically adjust the shape of the road so that it seamlessly merges with the
intersection object.

Figure 7.31 Connecting roads
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Chapter 8 Advanced Intersections
Making great intersections...

This chapter is about giving you some clues on how to develop good looking intersections in RapidPlan. Of course, we cant
show you every conceivable type of intersection and how its built, but we can expose you to an array of intersections that
employ different features and techniques, which you should be able to adapt to create intersections of your own.

8.1 What this Chapter Covers
We will be creating five different intersections of increasing complexity. In order to present as much information as possible in
the shortest space, this chapter will assume that you have all of the required knowledge from previous Chapters.

The process is fully mapped out in a step-by-step fashion, but not in so much detail as previously in this manual. Generally, we
won't be showing you the forms changed throughout the process, just the screenshots of the road in progress.

The intersections this chapter will cover:

Figure 8.1 Advanced Intersections covered in this Chapter

124



8.2 T-Intersections
T-intersections are the easiest of intersections to create in RapidPlan because the Roads tools make the task of joining roads at
angles simple.

T-intersection

This simple T-intersection makes use if the following items:
- Road tool 
- Turn Lane tool 
- Lane Marker tool 
- Lane Mask tool 
- Rectangle tool 
- Furniture from Signs Palette

Table 8.1

8.2.1 Create the Base Roads
1. Select the Road tool from the Roads tab in the Tools Palette and create an east-west road of two lanes.

2. Add a north-south road of two lanes as shown.

Figure 8.2 T-intersection Steps 1 and 2

3. Select the Turn Lane tool in the Roads tab of the Tools Palette and place it next to the right lane of the north-south road.

4. Click once to begin drawing the Turn Lane, click again mid-way to create the curve in the lane and click once more where
the lane intersects the east-west road.
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Figure 8.3 T-intersection Steps 3 and 4

8.2.2 Changing the Lane Markers
5. Select the Lane Marker tool in the Markings tab and draw a lane marking for the turning lane.

6. Now double click on the north-south road, select the Lanes tab and change the lane marker to double in the Markings
section.

Figure 8.4 T-intersection Steps 5 and 6
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8.2.3 Configuring the Road Markings
7. With the Lane Mask tool, mask out the broken line on the east west road across the intersection. (To make this clearer, we

have drawn the lane mask in Black for this tutorial).

Figure 8.5 T-intersection Step 7

8.2.4 Adding the Stop Bar and Turning Arrows
8. Select the Rectangle tool from the Shapes tab in the Tools Palette and draw a rectangle for a stop bar. It pays to zoom

right in when doing this.

9. Double click on your drawn rectangle and change the Stroke color to white.

Figure 8.6 T-intersection Steps 8 and 9

127



10. Select a turn arrow from the Furniture tab located within the Signs Palette and place it in the left lane. Select another and
place it in the other northbound lane. You will need to flip this one horizontally using the flip function on the Flip toolbar as
shown.

Figure 8.7 T-intersection Step 10
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8.3 Crossroads
Crossroads are similar to T-Intersections in many regards. Our simple crossroad will be a 4-lane east-west and 3-lane north-
south junction.

Crossroad intersection

This simple Crossroad intersection makes use if the following items:
- Road tool 
- Lane Marker tool 
- Lane Mask tool 
- Rectangle tool 
- Furniture from Signs Palette

Table 8.2

8.3.1 Create the Base Roads
1. Select the Road tool from the Road Tools tab and draw an east west road. Change it to four lanes

2. With the Road tool already in use, draw a north south road that intersects the 4-lane road and change it to a 3-lane road as
shown.

Figure 8.8 Crossroad Intersection step 1 and 2
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8.3.2 Set the Lane Markings
3. Double click on the east-west road. Select the Lane Markings tab and set marker number 2 to type double. Leave the

double lines yellow and change the dashed lanes to white.

4. For the north-south road, set marker number 2 to solid. Change both these lanes to white.

5. Using the Lane Mask tool from the Markings tab, mask out each of the lines through the intersection.

6. As we will need to completely change the road markings on the southbound approach, mask them out as well.

Figure 8.9 Crossroad Intersection steps 3 4 5 and 6

7. Using the Lane Marker tool, draw two new lane markings to replace the ones masked out on the southern approach. They
will be drawn as type solid color yellow by default. Double click on them and change their type so that they appear as
below.

Figure 8.10 Crossroad Intersection step 7
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8.3.3 Adding the Stop Bar and Turning Arrows
8. Using the Rectangle tool in the Shapes tab, create stop bars in the appropriate places. Ensure that your rectangle stroke

color is white (it will be black by default).

9. Select a Left turn or straight arrow from the Furniture tab of the Signs Palette and place it on the plan somewhere.
Ensure it is selected, then flip it using the flip horizontal button on the Flip toolbar. Drag it into one of the two required
places.

10. Duplicate your modified arrow. Drag the duplicate onto the other side of the intersection as shown.

11. Now select a Left turn arrow and place it in both required places. Make sure you flip it accordingly.

Figure 8.11 Crossroads Intersection steps 8 9 10 and 11
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8.4 Divided Roads
There are two ways to make divided roadways. The first method is simply to draw another carriageway next to your first. The
second method, which we will describe is more powerful.

Divided Roads

This Divided Roads makes use if the following items:
- Road tool 
- Lane Marker tool 
- Lane Mask tool 
- Rectangle tool 
- Polygon tool 
- Furniture from Signs Palette

Table 8.3

8.4.1 Create the Base Roads
1. Select the Road tool from the Roads tab and create a north-south road of 5 lanes. There will be 2 lanes in each direction

(total 4) plus the 5th to act as the median strip.

2. With the Road tool still selected, create a 2-lane road to form a T intersection and extend as shown below.

Figure 8.12 Divided Roads Intersection steps 1 and 2
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8.4.2 Create the Median Strips
3. Select the Rectangle tool from the Shapes tab in the Tools Palette and draw a rectangle over the center lane as shown.

Figure 8.13 Divided Roads Intersection step 3

4. Now select the Polygon tool from the Shapes tab and trace out the median as shown.

Figure 8.14 Divided Roads Intersection step

5. Double click each of the medians, and change their line width to 2 color white and fill to green. This makes our medians
look like they are grassed.

6. Using the Lane Mask tool from the Road Tools tab, mask out the unneeded lane lines running through the intersection.
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Figure 8.15 Divided Roads Intersection steps 5 and 6

8.4.3 Adding the Stop Bar and Turning Arrow
7. Select the Left turn arrow from the Furniture tab of the Signs palette and position it in the turning lane.

8. Finally, add a stop bar to the side road with the rectangle.

Figure 8.16 Divided Roads Intersection steps 7 and 8
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8.5 Slip Lanes
One of the most important skills in RapidPlan is learning to make slip lanes. Fortunately, they are very simple to do.

Slip lane

This T-intersection with a Slip Lane makes use if the following items:
- Road tool 
- Lane Mask tool 
- Rectangle tool 
- Control Points 
- Furniture from Signs Palette

Table 8.4

8.5.1 Create the Base Roads
1. Select the Road tool from the Roads tab and create an east-west road of 2 lanes, then add a north-south road.

Figure 8.17 Slip Lanes Intersection step 1
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8.5.2 Create the Slip Lane
2. Select the Turn Lane tool from the Roads tab and create a diagonal road as shown below.

Figure 8.18 Slip Lanes Intersection step 2

3. Move half way along the Turn Lane, right click and select Insert control point. Move the control point to shape the road
to a fluid curve as shown.

Figure 8.19 Slip Lanes Intersection step 3

4. Add any necessary pavement markings.

Figure 8.20 Slip Lanes Intersection step 4
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8.6 Overpasses and Underpasses
Whilst being one of the least frequently created arrangements, understanding how bridges and underpasses are constructed is
important because it demonstrates how ordering roads on the canvas can be used to achieve certain effects.

Overpasses and Underpasses

This Overpasses Plan makes use if the following items:
- Road tool 
- Ordering Canvas Objects 
- Polyline tool 
- Control Points 
- Layers

Table 8.5

8.6.1 Create the Base Road
1. Select the Road tool from the Roads tab and create an east-west road of 2 lanes.

2. Add 2 north-south extended lanes either end of the road. Make these one lane.

Figure 8.21 Overpasses and Underpasses steps 1 and 2
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8.6.2 Create the Next Road using Layers
3. Go to View from the status tool bar and tick the check box next to Layers List. The Layers Palette will now be visible

beneath the Properties palette. Add a new layer and name it Bridge as shown.

Figure 8.22 Overpasses and Underpasses step 3

4. Now stay on the Bridge layer and draw a 2-lane road that runs north south between the extended roads drawn in step 2.

5. Add two roads, convert them to single lanes and add 1 control point half way along each of the new side roads as shown.

Figure 8.23 Overpasses and Underpasses steps 4 and 5

6. Using the two control points on the side roads, shape them both down until they meet neatly with the side entrances to the
east-west road. We have left a gap in the top one so that you can see how we have done it.
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Figure 8.24 Overpasses and Underpasses step 6

7. Double click the bridge road and change the lane markings to double.

8.6.3 Drawing in Bridge Rails
1. Using the Polyline tool from the Lines tab, draw in the bridge rails.

Figure 8.25 Overpasses and Underpasses steps 7 and 8
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Chapter 9 The Marker Tools
Traffic plan specific tools...

Along with the sign tools, the marker tools are the second traffic plan specific toolset included in RapidPlan. These essential
items are used to mark important information items on your scheme in short spaces of time.

9.1 Delineators
Traditionally, one of the most difficult things to do when creating a traffic plan was run out lines of bollards, cones, barrels, etc.
The RapidPlan delineator tool allows you to drag out lines of devices in seconds.

Types of delineators available:

There are thirteen standard types of delineators available:

Figure 9.1 Types of Delineators
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9.1.1 Creating a Basic Delineator Line
All delineator lines start by default as Barrels with a size of 6 units and a spacing of 30 units. They can then be changed into the
required type after placement on the plan. You can also set new default values from the Properties palette.

To create a basic delineator line:

Select the Delineator from the Devices tab in the Tools Palette.

Click once where you wish to start drawing (don't hold).

Click at each corner for your line.

After you have placed the end point, right click to stop drawing.

Right click to clear the cursor.

Figure 9.2 Delineator Line
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9.1.2 Changing the Type of your Delineator
Once your line is on the plan, you can change the type of delineator that you use from the list on the previous page.

To change delineator types:

Select the delineator line on the plan and observe the Properties Palette.

Click on the Devices tab and choose the type of delineator required from the Type drop down box.

Figure 9.3 Changing Delineator Type

9.1.3 Changing the Properties for the Delineator
As always, more in depth editing is done via the Properties palette. The following properties can be edited for each delineator:

Devices - Type, Size, Spacing, Alignment

Style > Geometry - Line, Spline, Bezier

Figure 9.4 Delineator Properties Palette
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9.1.4 The Buffered Delineator Tool
The Buffered Delineator tool works much the same as the Delineator tool with an added buffer zone. It can be manipulated to
the shape you need and you can change the delineator.

Figure 9.5 The Buffered Delineator
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9.2 The Arrow Board
They come by many names, flashing arrow boards, sequential arrow boards, arrow trailers or even illuminated trailer mounted
sequential flashing arrow systems. In RapidPlan they are referred to as Arrow Boards. They are simple to place and use and
come with various configurations for the required site setting.

Figure 9.6 An Arrow Board at the End of a Transitional Taper

There are six different Arrow Board patterns available in RapidPlan:

Patterns

Single Double

Warning Cautionary

Chevron Diamonds

Table 9.1 The Available Arrow Board Patterns
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9.2.1 Placing an Arrow Board:
Select the Arrow Board from the Devices tab in the Tools Palette.
Drop it into position on the plan.
Rotate it as necessary. Note: by default it appears as a Right flash - if you require a left flash, use CTRL + R (twice) to
change its orientation.

9.2.2 Changing the Pattern on the Arrow Board
Double click on the Arrow Board placed on your plan to enter the Quick Edit screen.

From the Board tab set the desired pattern from the Style tab and click on the Icon drop-down box.

Figure 9.7 Changing the Arrow Board Pattern
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9.3 The VMS Board
Like the Arrow Board, Variable Message System (or VMS) boards have many different names. We describe a VMS board as any
electronic sign capable of cycling through multiple frames in order to display a textual message.

9.3.1 The Layout of the VMS Board
In order to conserve space on the plan, the VMS Board is organized with one line for each frame as shown below.

Figure 9.8 The VMS Board on a Plan

On the roadway, the top line would occupy the first frame, the middle the second and so on. The VMS Board may take up many
different panels (although in many jurisdictions, VMS message sequences are mandated as being less than five panels).
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9.3.2 Creating a VMS Board
Select the VMS Board from the Devices tab in the Tools Palette and place the panel in the desired location on the plan.

Set the number of panels (or frames) using the Panels section of the Properties Palette.

Enter the text for each frame in the Messages section of the Properties Palette.

Deselect the VMS board to finish.

Figure 9.9 Creating the VMS Board

9.3.3 Editing a VMS Board
To edit a placed board, simply double click on it and the form will reappear allowing you to make your changes.
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9.4 The Lane Status tool
This tool allows you to quickly and easily place lane status arrows or objects on you plan. A Lane Status Wizard box will open
once this tool is selected where you can edit markers and add, flip, or remove lanes.

9.4.1 The Lane Status Wizard
Upon selecting the Lane Status tool, a wizard box will open where you can make all necessary changes to lane status situations.
Within the wizard there are several status arrow options to choose from and multiple lane signs can be added as shown on
Figure 9.10.

9.4.2 Creating a Lane Status Marker
Select the Lane Status tool from the Devices tab in the Tools Palette.

Edit these markers accordingly depending on lane closures and lane numbers needed within your plan.

Remember you can Add and Delete panels, as well as adjust an arrow horizontally/vertically if need be

Move your mouse over the individual marker you'd like to change and make the desired changes.

Click create to place the marker on your plan.

Figure 9.10 Lane Status Wizard with Available Options
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9.5 LUMS Board (Australian Version Only)
This tool helps you create a Lanes Use Management System (LUMS) across a roadway on your plan. There are 10 different
LUMS styles available for your plan.

Patterns

100 km/h 80 km/h

60 km/h 40 km/h

Merge left Merge right

Exit left Exit right

Cross Blank

Table 9.2 LUMS Board Options

9.5.1 Creating an LUMS Board
Select the LUMS Board tool in the Devices tab in the Tools Palette.

Click once to place an LUMS Board the first lane, continue this for each lane.

Once all of your LUMS Boards are set, you can select each one and change its style in the Properties Palette under the
Style tab and the Icon drop down menu.

Right click to finish

Figure 9.11 LUMS Board Properties Palette
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9.6 The Multi Message Marker (Australian Version Only)
This marker operates very similar to the Lane Status marker in that it allows for the creation of one message board which
displays multiple signs. The main difference between the two markers is that the Multi Message marker displays actual signs
with messages as the marker implies, as opposed to only allowing for Lane Status signs to be used when working with the Lane
Status marker.

There are five different sign sizes you can work with, each size tab will display the signs available within that size category.

Image Sign size Available signs

600x300 2 signs of this size can be used with one 1200x600 sign or two 600x600 signs.

600x600 2 signs of this size can be used or one 1200x300 sign or two 600x300 signs.

600x900 2 signs of this size can be used.

1200x300 1 sign of this size can be used with one 1200x600 sign or two 600x600 signs.

1200x600 1 sign of this size can be used with one 1200x300 sign or two 600x300 signs.

Table 9.3 Multi Message Sign Sizes

Figure 9.12 A Multi Message Marker Displaying two 600x600 Signs with One 1200x300 Sign
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9.6.1 Creating a Multi Message Sign
When this tool is selected, a Multi Message Sign Wizard box will appear where you make all the necessary adjustments to
the message board you will be utilizing in your plan. You will have many different signs to choose from and select up to four
signs for the message board. You can filter signs by state's library (QLD, SA, VIC, WA) and you can have your own Custom
Signs.

Figure 9.13 MMS library

Multi Message sign placement:

Select the Multi Message Sign tool from the Devices tab in the Tools Palette

Toggle through the size tabs to view the signs available in each size category and preview the placement of each sign in
the preview pane on the right

Select the signs and placement you want to add to the message board

Click Create to update the marker

Figure 9.14 Create a new Multi Message Sign
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Click on Upside down checkbox if you need to replace pane position and Flags if you need on top corners of Multi Message
Sign.

Figure 9.15 MMS upside down with flags

If you use some of the signs very often, you can bookmark it. Right click on sign you want to place on Bookmarked panels
and select Add to Bookmarks. To remove it from Bookmarked panels right click on bookmarked sign and select Remove
from Bookmarks

Figure 9.16 MMS bookmark sign
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If there are some signs that you never use them, you can hide it from your signs list. Right click on sign you want to hide and
select Hide panel (Note: It will be hidden even if it is placed on Bookmarked panels).

Figure 9.17 MMS hide panel

To show hidden signs, click on Show hidden checkbox and you will see all the signs. Hidden signs will be grayed out.

Figure 9.18 MMS hidden signs
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9.6.2 Adding a Lane Status Sign to your Multi Message Marker
You can also add a Lane Status sign to your Multi Message sign in the 600x600 size for two lanes, or 1200x600 size for four
lanes.

Adding a Lane Status to you Multi Message sign:

Select the desired size depending on number of lanes.

Select the Lane Status Icon (see Figure 9.19).

You will be directed to select a Lane Status Arrow for each lane.

Select Save and complete your Multi Message Sign and select Create.

Figure 9.19 Adding a 1200x600 Lane Status Sign to the Multi Message Sign

Figure 9.20 Setting the Four Lane Statuses

154



Figure 9.21 Creating the Lane Status Multi Message Board
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9.7 The Work Area and Safety Zone Tools
There are many reasons why it's important to show exactly where the work is to be performed. Probably the most obvious is
that road body scrutineers will likely want to know, and just as importantly, your work staff should also be able to see so that
they can adjust their set up accordingly if site conditions are not what is depicted on the plan.

The other important feature of a work site is the indication of a safety or buffer zone between the end of the transitional or
taper area and the commencement of the works. It's a good habit to include a safety zone on your plans because it will remind
your site staff that they should leave sufficient room should a wayward vehicle run into the site.

9.7.1 Creating a Work Area and Safety Zone on a plan

Both tools are simple polygons that are drawn on the plan. Aside from the way they look they both behave identically.

Figure 9.22 Work Area (Green) and Safety Area (Yellow) on a Plan

To place a Work Area or Safety Zone on a plan:

Select the appropriate tool from the Zones tab in the Tools Palette.

Click at the first corner point of your required area and continue clicking to set corner points (see Figure 9.23).

When the final point is placed, right click to stop drawing.

Right click to clear the cursor.

Figure 9.23 A Click Pattern for a Simple Buffer Area
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9.8 The North Arrow
A North pointer Arrow or Star can be placed on your plan and rotated accordingly to allow viewers to see which way is North.

9.8.1 Creating a North or Star Arrow
Select the North Arrow tool from the Annotations tab in the Tools Palette.

Select it to see it in the Properties Palette.

Change the Style from Arrow to Star or vice versa from the Style tab and the Icon drop down menu.

Figure 9.24 Changing the North or Star Arrows Properties
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9.9 The Scale Marker
This tool is handy for advising viewers of the plan that there is a scale set. You are able to set the plan distance in Imperial and
Metric system.

9.9.1 To place a Scale Marker
Select the Scale Marker from the Annotations tab in the Tools Palette.

Click once anywhere on your plan to place the marker.

Edit the values for the marker within the Properties Palette.

Figure 9.25 Scale Marker and Properties Palette
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9.10 The Legend Box
This tool enables you to place a legend box on your plan. There is a Legend & Manifest tab in every item's properties allowing
you to select to show the item on the legend. Legend Box can be used to trace entries back to the actual on-plan objects they
represent.

Figure 9.26 Legend box

9.10.1 Creating a Legend Box
Select the Legend Tool from the Annotations tab in the Tools Palette
Place this in the desired location on your plan
Select an item on your plan that you want to appear in the Legend Box by clicking on it once
Under the Legend & Manifest tab in the Properties Palette make sure the Show in Legend section is set to True
Do this for any other items on your plan you wish to appear in the legend

Note: The legend box does not need to be visible on the plan for you to set an item to appear in the legend box. Therefore, you
can set any item to Show in Legend as you build your plan and place the complete legend box at the end.

In the example below, a delineator has been set to True, so it will appear in the legend.

Figure 9.27 Setting a Delineator to Appear in the Legend
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9.10.3 Changing the Legend's Properties
Like any other item in RapidPlan, the Legend can be customized through the Properties Palette, including title, size, color, etc. as
you can see in Figure 9.28.

Figure 9.28 Legend Box Properties
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9.11 The Manifest Box
The Manifest Box works similarly to the Legend Box. The difference is, when you set an item to appear in the manifest box, if it
has the relevant dimension, you can set the Manifest Value to either the dimensions or the number count (considered the
default). And like Legend Box, Manifest Box can be used to trace entries back to the actual on-plan objects they represent.

As you can see in the example below, the Cones Manifest Value is set to show the number count and the Work Area and
Barrel is set to show the dimensions.

Figure 9.29 Manifest values

Below is an example of a delineator being set to Show in Manifest and selecting the Manifest Value.

Figure 9.30 Delineator Manifest Property Options
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9.11.1 Changing the Manifest Box's Properties
Below is an image of the Manifest Properties Palette, showing all of the features that can be adjusted.

Figure 9.31 Manifest Box Properties

9.11.2 Export Manifest Tool
The Export Manifest Tool allows you to create manifest documents based on one or more traffic control plans, then print or
export to a range of formats: PDF, Text, CSV, XML and JSON. Access the export tool by right clicking on a Manifest Box, or via
File > Export > Batch Export > Export batch manifest...

Step 1:

Right click on Manifest and select Export manifest...

Figure 9.32 Right click manifest export
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Step 2:

Order manifest items (by name, by value or custom/manually)

Set the units

Set document header (and optional custom description)

Select export format

Figure 9.33 Manifest export
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And this is an example of exported manifest to PDF

Figure 9.34 Manifest pdf example

9.12 Number stamper
Use the number stamper to quickly annotate objects on your traffic control plan.

To use the number stamper it's just a matter of clicking the Number stamper tool, located under Annotations, in the Tools
palette.

Once selected, you can then annotate objects on your plan, by left clicking next to each object in sequence (e.g., 1, 2, 3, 4)

This tool can be useful for labelling devices on your plans, numbering project stages/phases, etc. The Properties of the stamper
are also editable, enabling you to alter it's design and value - as shown in Figure 9.35 below.
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Figure 9.35 Number stamp
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9.13 The Title Box
The Title Box is an essential item on your plan - it captures a lot of important information about you and your works in one
convenient location.

Figure 9.36 Example of a Title Box

The Title Box has provisions for the following information:

Date
Author
Project
Custom details
North marker
Company logo
Comments field

9.13.1 Creating a Title Box
Creating a title box is a simple matter of selecting, filling and placing on the canvas.

To place a Title Box:

Select the Title Box from the Annotations tab in the Properties Palette and place the box on the plan.

Double click on the Title Box to open Quick Edit.

Fill in each of the required fields and click Save.

Figure 9.37 Filling in the Title Box in Quick Edit

Note: As always in RapidPlan, this editing can be done from the Properites Palette.
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9.13.2 Filling in the title box fields
Entering data into the title box is very easy, but because a number of fields are quite unique in nature, we will cover them one
by one.

9.13.2.1 Manipulating the title box

The title box can be moved, rotated, resized, cut copied and pasted just like any other item on the canvas. Simply select it and
make any changes as required.

9.13.2.2 Date, Author, Project, and Comments Field

These are all simple text entry fields. Note that the Date field doesn't have an input mask, so you can enter your date which ever
way you like.

9.13.2.3 Custom Details

Because we don't know every field, you are likely to need, we have included a custom details field where you can give your plan
a Label and a Value.

Naming the fields is simple, first click on the Add icon and enter the appropriate values for Label and Values as shown below,
then click Save.

Figure 9.38 Adding Custom Details to a Title Box

Note: Instead of entering Label and Value text, you can also delete the words Label and Value and enter your own custom
information.
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9.13.2.4 The North Marker

The north marker is a handy tool to give your audience an idea of the plan orientation. Its also very easy to use.

In the North Arrow tab of the Properties, simply click on the Show section to make it True, then adjust the direction of the
arrow with the Angle bar as shown below.

Figure 9.39 Displaying the North Arrow in the Title Box

9.13.2.5 The Logo Placeholder

An added hint of professionalism (and identification) is achieved by adding a logo to your plan.

You will need to have a high quality logo, preferably in JPG, BMP or PNG format.

To include the logo on a title box:

Click on the Company Logo tab in Properties.

Hover your cursor over the Image section until the option to Load File From becomes visible. Select this.

Browse for your image files on your computer, double click on your file once you've found it.

Do not forget to make the Show section True to make your logo visible in the Title Box.

Figure 9.40 Add Company Logo on the Title Box
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9.14 Zoomed View Box Tool
The Zoomed View Box tool allows you to create an inset that presents a detailed view of a specific section in a larger plan.

9.14.1 Creating Zoomed View Box
1. Select the Zoomed View Box tool from the Annotations tab in the Tools Palette

2. Select the area you want to enlarge

3. Set the place where you want to put zoomed box

4. Set the size of box

Figure 9.41 Zoomed View Box

9.14.2 Changing Zoomed View Box Styles
The Zoomed View Box can be styled to present its content in an ellipse or cloud-shaped box.

Once the zoomed box has been created, select it and a number of options will be available in the Properties palette to suit your
plan requirements.
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Figure 9.42 Zoomed view box style
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9.15 Distance Markers
There are six distance markers used for indicating spatial information on your plan, the Distance Marker, the Combined
Distance Marker, the Offset Distance Marker, the Angle Marker, the Area Marker and the Combined Offset Distance Marker.

In essence, all six distance markers do exactly the same thing - they indicate to a reader the distance between elements. They all
automatically calculate the distance and enter its amount. You can also enter your own values if needed.

9.15.1 Creating a Distance Marker
Irrespective of which distance marker you are using, the technique for creating it is much the same. However, there are some
differences, so this will be explained separately for each marker below.

To place a Distance Marker:

Select the Distance Marker tool from the Marker tab in the Tools Palette.
Click once to start drawing the distance marker, click a second time to mark the end point.
Right click to finish

Note: It is helpful to hold SHIFT whilst drawing the distance marker to keep it straight.

9.15.2 Changing the Distance on the Marker
Select the Marker

Double click on the distance number provided

The writing cursor will appear and will allow you to enter your desired distance

Click anywhere on your plan to finish

Figure 9.43 Changing the Distance on a Distance Marker
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9.15.3 Changing a Distance Marker's Properties
For each of the distance markers, you can change the arrow size, stroke width and color, font color etc. Utilize the Properties
palette to edit all settings for each marker.

Figure 9.44 Distance Marker Properties Palette

9.15.4 The Six Distance Markers
9.15.4.1 Distance Marker

The Distance Marker calculates one distance.

Figure 9.45 The Distance Marker Tool

Note: For steps for placing this distance marker see section 9.14.1 Creating a Distance Marker.
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9.15.4.2 Combined Distance Marker

This tool does the same as the Distance Marker but with the ability to show multiple distances as shown below.

Figure 9.46 The Combined Distance Marker Tool

To place a Combined Distance Marker:

Select the Combined Distance Marker tool from the Marker tab in the Tools Palette.
Left click once to start drawing the distance marker, left click again to end the first distance marker and start the second
Repeat this until you have all of your distances marked for that marker
Right click to finish

9.15.4.3 Offset Distance Marker

This tool allows you to un-clutter items on your plan by being "offset" from its true location.

Figure 9.47 The Offset Distance Marker Tool

To place an Offset Distance Marker:

Select the Offset Distance Marker tool from the Marker tab in the Tools Palette.
Click once to start drawing the distance marker, click a second time to mark the end point.
Drag your mouse laterally away from the distance marker to set the offset. Click a third time to finish drawing the marker.

173



9.15.4.4 The Angle Marker Tool

This tool enables you to show angle degrees on your plan.

Figure 9.48 The Angle Marker Tool

To place an Angle Marker:

Select the Angle Marker tool from the Marker tab in the Tools Palette.

Click the space you wish to measure (the first click will be the angle measured)

Click a second time to mark the base point of the angle.

Drag your mouse in the direction you want to measure and click to finish the angle once it is set to the desired
degree/location.

Figure 9.49 Placing the Angle Marker

Note: Like any item in RapidPlan, the angle marker, once made, can be moved and adjusted, with the degrees changing
accordingly.
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9.15.4.5 The Area Marker Tool

This tool calculates the area you allocate which is shown as the cross-hatched netting in the image below.

Figure 9.50 The Area Marker Tool

To place an Area Marker:

Select the Area Marker tool from the Marker tab in the Tools Palette.
Left click once to start drawing.
Continue clicking to set corner points of the area.
Right click to finish.

9.15.4.6 The Combined Offset Distance Marker Tool

This tool allows you to create a combined marker that is offset on your plan.

Figure 9.51 The Combined Offset Distance Marker Tool

To place an Combined Offset Distance Marker:

Select the Combined Offset Distance Marker tool from the Marker tab in the Tools Palette.
Left click once to start drawing the distance marker, left click again to end the first distance marker and start the second.
Repeat this until you have all of your distances for that marker.
To finish the last distance press right click.
Drag your mouse laterally away from the distance marker to set the offset. Click a third time to finish drawing the marker.
Right click to finish.
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9.15.4.7 The Distance marker breakline

When not drawing to scale, use the Breakline property of a Distance Marker to indicate whether the marker symbolically
represents a larger on-site distance.

To enable the breakline, simply select the distance marker, in its Properties there is a subheading for Breakline.

Simply change it from False to True and it will set the breakline in the middle of your marker. You can also adjust the size
directly underneath.

Figure 9.52 Marker Breakline
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9.16 Arrows
Frequently, you will need to draw attention to items on the plan, but will not want to use a callout box. RapidPlan provides two
arrow tools for this purpose:

The Arrow Tool
The Arrow Text Tool

As the names suggest, the latter carries a text component at its base. The arrows can be curved or straight, as shown.

Figure 9.53 The Arrow tool and The Arrow Text Tool

9.16.1 Creating an Arrow
Select the Arrow tool from the Lines tab in the Tools Palette.
Click to place the head of the arrow.
Click again for each subsequent turn point that you require.
When you have placed your final point, right click.
Right click to clear the cursor.
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9.16.2 Creating an Arrow Text
Select the Arrow Text tool from the Text tab in the Tools Palette.

Click to place the head of the arrow.

Click again for each subsequent turn point that you require.

When you have placed your final point, Right click and a text cursor will appear for you to write your text in (Note: This can
be edited in the Properties Palette).

Figure 9.54 Adding Text to the Text Arrow

Note: To create a straight arrow, hold SHIFT whilst drawing the arrow.
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9.17 Callout Boxes
The Callout box is a great way to draw attention to important items on your plan that need to be noticed. They look great and
are simple to use. You can change their color, shape, fill style and text type to make your message clearly stand out.

Figure 9.55 Callout Box

9.17.1 Creating a Callout Box
Select the Callout box from the Text tab in the Tools Palette.

Click on the plan where you want to place the pointer of the callout box.

Move the mouse to where you wish to place the body of the callout and click again.

A text cursor will appear for you to write your text in the box (see Figure 9.56).

Click anywhere on your plan to complete the callout box.

Figure 9.56 Callout Box Ready for you to Add your Text
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9.17.2 Other Callout Properties
If you want your callout to stand out ever more, or have some sort of coding that you would like to apply on your plans, you
can also change the fill type and color, stroke and color.

Figure 9.57 Callout Box Variations

Refer to the Properties Palette to edit your callout box with more editing tools.
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Chapter 10 The Basic Tools
The building blocks of RapidPlan...

There will be occasions where you need to build something for your plan that isn't included in the galleries. You might want to
build some sort of landmark (like a mail box, or hydrant) to indicate the start of a job or you might use special equipment in
your work that we haven't included. For this reason, RapidPlan has a wide range of basic tools including a variety or shapes,
line tools, text tools and image importing which you can use to draw virtually anything you need.

The other very important purpose of these basic tools is to allow you to create signs. Every sign in RapidPlan is a collection of
these basic tools which have been grouped and saved.

See Chapter 12 for Creating your own Signs.

10.1 The Tools
There are 20 different basic tools you can use. The majority are classed as either lines, or shapes. The Text and Image tools
operate differently to all the others.

The Lines tools The Shapes tools The Text tools The Image import tool

Figure 10.1 Lines

Figure 10.2 Shapes

Figure 10.3 Text

Figure 10.4 Image

Note: The Arrow, Text Arrow and Callbox are all covered in Chapter 9.
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10.2 Using these Basic Tools
The technique for drawing with these tools varies from object to object. Many of the objects such as Rectangles, Ellipses, and
Rounded Rectangles are simple two-control point structures. Polylines, Polygons, Splines, Arcs, and Beziers can have as many
points as you like. Irrespective, the process is simple.

10.2.1 To Draw any Line or Shape
Select the tool from the corresponding tab in the Tools Palette.
Click to place the first control point.
Continue clicking until the necessary number of points are placed and the object is complete.
Right click to stop drawing.
Right click again to drop the tool.

10.2.2 Auto Aligning Lines and Shapes
To ease the creation of these items, there is a very useful auto align feature which allows you to keep the dimensions of your
lines and shapes square.

In most cases, holding SHIFT while you draw will cause the control points you are placing to align themselves to a 90Âº or
45Âº increment. This means that you can keep your verticals and horizontals perfectly straight.

Rectangles, Rounded Rectangles and Ellipses form special cases - holding SHIFT still keeps their second control point at 90Âº
or 45Âº but this of course has the effect of holding the rectangles to perfect squares and the ellipse to a perfect circle.

Figure 10.5 Drawing a Rectangle and an Ellipses Freehand compared to drawing them holding Shift
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10.3 Properties of these Basic Tools
As is the case with all objects in RapidPlan, you can view and change the properties of a basic tool by double clicking on it to
open the Quick Edit screen or from within the Properties Palette.

The properties for the Lines are very similar. This is also the case with the Shapes. Regardless of type, all the basic tools have
the option to be rotated or flipped vertically and horizontally by using CTRL + R to rotate and the flip toolbar to flip the objects.

10.3.1 The Lines Properties
The properties of the Lines are defined by setting the style of stroke used:

Figure 10.6 Polyline Properties Palette

Properties

Stroke width The weight of the line (default is 0.75).

Stroke color The color of the line.

Stroke style A variety of dashed, solid and dotted line styles are available.

Stroke caps Choose from four line end styles: flat, square, round, and triangle.

Table 10.1 Lines properties
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10.3.2 The Shapes Properties
A shape is defined by its outline and an internal area - each handled separately. Similar to lines, the shape's outline style is set
by altering the stroke settings. The properties for the internal area are set by modifying the fill used for the shape.

Figure 10.7 Rectangle Properties Palette

You have three controls for the fill: Color, Opacity and Style.

Figure 10.8 The Available Shape Fill Styles
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10.3.2.1 The "Transparent" Color

One of the color settings for lines, shapes and text is transparent. In the case of lines including shape outlines this effectively
just means none. For the fill of shapes however, a transparent setting allows you to see what's underneath. Don't confuse
transparent with white. As the diagram below shows, they are very different.

Figure 10.9 The Box on the Left has a Transparent Fill the Box on the Right has a White Fill
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10.3.3 The Spline-Based Tools
The Spline and Filled Spline have an extra property. They are different because they are built around what is known as a
spline curve. Spline curves are formed by placing points along a desired path - RapidPlan uses a predefined curve radius and
creates the curved line. (The road tool also is a spline curve).

Figure 10.10 The Spline Tool on the Left and the Filled Spline on the Right

10.3.4 The Bezier Tools
One of the trickier techniques to master in RapidPlan is the drawing of a Bezier. Beziers offer a powerful way to create curves
with great precision.

There are two components of a Bezier curve:

The center Control Point sets the apex of the curve.

The Curve Handle allow you to set the direction and sweep of the curve.

Figure 10.11 Bezier with its Control Points and Curve Handles
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10.3.4.1 Drawing a Bezier

When you are using either the Filled Bezier or the Bezier tool, it is important to understand that, depending on the technique
you use, there are two different types of control points you can lay down.

A regular Control Point (without the Bezier functionality) is placed if you simply click, release the mouse button then move on.

A Bezier style control point (with Curve Handles) is placed if click, hold, drag, and unclick as you drop out a point.

The tools are designed this way so that you can create a shape or line that has both curved and straight corners, such as the one
below:

Figure 10.12 Control Point 1 was dragged when placed and Control Points 2 and 3 were not

10.3.4.2 Using the Curve Handles

Using the Curve Handles may initially seem a little tricky, but once you have had some practice, most people prefer the Bezier
to the Spline because of the precision it offers. The crucial factor is the location of the handles relative to the control point itself,
the further from the control point, the wider the sweep of the curve and vice versa. To manipulate the curve handles, click on
CTRL and one of the handles and move your mouse in any direction. Using our shape from above, the effect of the curve
handles is easily seen.

Figure 10.13 The same Curve with the Curve Handles in different Configurations
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10.3.4.3 To Modify a Bezier Curve Handle

Click on the shape or line to reveal its control points.
Click on one of the two curve handles until the mouse cursor changes to a +.
Hold down CTRL and drag the curve in and out.

10.3.4.4 Converting non-Bezier Control Points

If you place a regular control point on a Bezier or Filled Bezier but decided you need to turn it into a Bezier point, this is easily
achieved.

To convert a standard control point to a Bezier control point:

Select the Filled Bezier or Bezier by clicking on it once.
Click once on the control point you wish to convert. (The cursor will change to a +.)
Hold down CTRL on the keyboard and drag the handles in or out as you choose.
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10.3.5 The Arc Tools
There are three arc-based tools in RapidPlan, the Arc tool, the Pie Arc tool and the Road Arc tool. All of these tools are created
from a radius, making perfect curves.

To use an arc tool:

Select the necessary arc tool from the Tools palette.
Click once to set the radius of the arc.
The second click is where you draw your arc by moving the cursor in the direction of the arc.
Click to complete the object.
Right click to drop the tool.

You can also specify numeric values for the radius, start angle and end angle for the arc.

Figure 10.14 Setting the Radius and Angles of the Pie Arc Manually

189



10.4 The Text Tools
Because they are different, the text tools behave differently to the other tools. They are however exceptionally easy tools to use.
You can enter and edit text in these objects on the canvas simply by double clicking directly on the text, even on grouped
objects and signs.

10.4.1 The Text Object Tool
This tool creates an object out of text that can be manipulated like any other object.

Select the Text Object tool from the Text tab.

Place it on the canvas with a click, then a writing cursor will appear in that place.

Type in your content then use the Properties Palette to make any changes.

If you wish to change the text content, font style, size or color, or to center the text, click the Text tab in properties and make
any necessary adjustments.

If you wish to paint the background of the text box, click the Box tab in properties and make your adjustments.

Figure 10.15 Text Object and Properties
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10.4.2 The Text Box Tool
The Text Box is created in a similar way to the Text Object tool but the products are different. The difference between the Text
Object and the Text Box tools is the Text Object literally creates an object that can be stretched and manipulated like any other
in RapidPlan, whereas a Text Box is literally a text box.

Figure 10.16 Text Object vs Text Box

10.4.3 Changing Default Text Settings
By default RapidPlan will create Arial 14pt text. This can be changed through the RapidPlan Preferences screen or from within
the Properties palette.

10.4.3.1 To set a new Default Font through the Preferences Screen

From the main menu Select Tools > Preferences.

Select the Defaults tab (see Figure 10.17).

Scroll down to the Fonts and Text section.

Set the font as you require or set any other parameters you desire.

Exit Preferences by closing its tab.
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Figure 10.17 Font Default Preferences

10.4.3.2 To set a new Default Font through the Properties Palette

Select the Text Object tool from the Text tab.

Click on the canvas and enter you text in the allocated area.

Use the Properties Palette to set the font as you require or set any other parameters you desire.

Click Save as Default Style at the base of the palette when complete.

Figure 10.18 Saving New Default Font in the Properties Palette
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10.4.4 The Text Pair Tool
The Text Pair tool operates similar to the regular text tool but with limited editing capabilities. For instance, you cannot set a
background color with the text pair tool nor can you set your fonts to bold. This tool only provides a Label and a Value to be set
thereby giving it it's name as a text pair.

To use the Text Pair tool:

Select the Text Pair tool from the Text tab.

Click on your canvas to place the text box and enter your desired text for your Label. (In the example the Label is Invarion).

Enter your desired text for your Value. (Plan 456 is the Value in the example).

Use the Properties Palette to set the orientation of the text. (Horizontal or Vertical)

Figure 10.19 Text Pair Properties Palette and Outcome
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10.4.5 The Path Text Tool
Just as the name implies, this tool allows you to create text fit to follow a path. It is used as a hybrid of a spline and text tool.

Figure 10.20 The Path Text Tool
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10.4.6 Text variables
New feature in RapidPlan is Text Variables tool. The Text Variables can be used to create reusable templates and objects
where text can be auto-filled based on built-in or custom variable values. Custom variables can be defined for a single plan
only, or application-wide. To open the list of variables go to Tools > Text Variables.

Figure 10.21 Text variables list

To create a new custom variable, open the Text Variables tool, click on + Create a new variable button at the top. Name your
custom variable, enter the value, then press the Save button.
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Figure 10.22 Create new variable

Figure 10.23 Text variable example
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Custom variables cannot start with ' _ ' (underscore) or contain '$' (dollar sign) or whitespace

Figure 10.24 Invalid variable name

When editing text, type the '$' character to see the list of available variables. Select the variable. Click off the object and the
variables will be replaced with values taken directly from the diagram (Author, Date, Plan title, etc.). Note that the text is still
editable and can be changed at any time. Text variables can be particularly useful when you want to copy a object containing
text across to another plan. The object will not need to be edited, as the variables will adjust the text to reflect the values of the
new plan. This makes the variables an excellent tool for creating generic templates or print frames that dynamically adjust to
specific plan values.

Figure 10.25 Text variables suggestion list

Note: Text variables can be used on any object containing text (signs, etc.).

10.4.7 Hyperlink tool
The Hyperlink text tool can be used on your plans to reference online resources and other files via clickable links on exported
PDF documents.

To activate the tool, select Hyperlink from the Text tab.

Click on your the canvas area to type in the Text you wish to have as your clickable link, in the Custom URL area you can enter
the link for the website or document you wish to hyperlink.

When the plan is exported to PDF, the reader will be directed to the web page or document when the hyperlink is clicked.
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Figure 10.26 Hyperlink tool

10.5 The Image Tool
We won't get into detail with this tool since it is simply a way to import image files to your RapidPlan drawing. Once you select
the Image tool from the Tools Palette, you will be presented with a typical Open box where you can search your computer for
image files you want to import.
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Chapter 11 Using The Signage
11.1 Using signs
Because RapidPlan contains all the tools necessary to create your own signs, we need to devote an entire section of the user
manual to this topic. Therefore, the signage section of the user guide is broken into two halves. This Chapter deals with using
the signs in RapidPlan (placing/rotating/resizing/etc.). The next Chapter is for advanced users, and covers the creation,
modification and saving of signs.

11.1.1 The Signs Palette
The sign palette is the repository for each of the signs in RapidPlan. Aside from the signs themselves, the signs palette has three
main components:

The Sign Library

The Sign Categories

Search Signs

Figure 11.1 Signs Palette

11.1.1.1 Sign Library

This drop down control allows you to select which signage pack you wish to use. In some cases you will only have one pack
installed, but certain countries will have numerous state/region packs also installed. Changing the sign pack often changes sign
tab options.

11.1.1.2 Sign Categories

The signs are organized into tabs so that they are easy to find. Clicking through the tabs will reveal the signs for each category.
You can view and example of the categories in Figure 11.1 above.
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11.1.1.3 Search Signs

New version of RapidPlan allows you to search entire signs library by a keyword, phrase, sign name or sign code. For example,
if you were looking for a STOP sign, you can search it by name stop or by code R1-1.

Figure 11.2 Sign search

Note: R1-1 is code for STOP sign in Australia, other countries codes may vary

11.1.2 Setting the Sign Icons Size in the Palette
You can change the size of the signs in the palette. This is helpful when using a screen at very high resolution, or just for users
who are having difficulty with the small icons. By default the sign icon size on the palette is set to medium.

To change the signs icon size:

Click on the bar at the base of the Signs palette to make options appear.

The size bar will pop up enabling you to select a different size (see Figure 11.3).

Figure 11.3 Icon Size Bar
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11.2 What is in a sign?
We won't bother going into too much detail about the composition of a sign here - that's what the next Chapter is for. However,
it does help to know a little bit about how the signs are built as it will give you an understanding of what they can do.

Each sign in RapidPlan has its own sign file saved on your computer, and almost every sign file contains multiple variations of
the same sign. A typical sign has four variations.

Figure 11.4 Sign Variations

The reason behind the multiple variations lies in the features of the RapidPlan canvas:

When Fax Mode is selected, the signs need to be able to be displayed in black and white.
When Sign Designations are turned on, the software needs to be able to display a variation of each sign with its code.
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11.3 Using the Signage

11.3.1 Placing Signs
Placing signs is simple. Once your sign is placed you can move, resize and rotate it.

To place a sign:

Select the desired sign from the Sign Palette by clicking on it.
Float the sign out onto the canvas with the mouse. (You don't have to hold the mouse button while you drag your sign.)
If you want to rotate your sign 90 degrees; use CTRL + R.
Click to drop the sign on the canvas.

11.3.2 Rotating Placed Signs
As is the case for most RapidPlan items, once a sign is placed on the canvas, there are three ways to rotate it.

Whilst free rotate is probably the easiest to do, it probably isn't ideal if you are aligning more than 1 sign. It can be fiddly to get
signs all pointing in precisely the same direction, so often you are better off using the right-click Rotate option, or CTRL + R.

To rotate in set 90 degrees increments:

Select the placed sign
Press CTRL + R repeatedly to rotate the sign 90 degrees clockwise

To Rotate by set angle:

Right click on the sign to reveal the context menu.

Click on Transform > 90 degrees, 180 degrees, 270 degrees or Rotate by custom value

Figure 11.5 Rotate 90 Degrees Sign from Context Menu
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To free rotate:

Select the sign that you wish to rotate. The rotation handles will become available for use.

Using the rotation handle, drag the sign around until it is positioned as you require.

Figure 11.6 Rotation Handles

Note: The rotation handles are the arrows placed at each corner of the sign, the arrow will turn red when the cursor is
place over of it which means it is ready to use.

11.3.3 Resizing Signs
Resizing signs in RapidPlan is no different to resizing any other object. Its achieved using the resize handles which appear when
the sign is selected.

Figure 11.7 Resize Handles

The sign is resized by simply dragging out the resize handles. However, there is one important factor that you should take into
account when resizing your signs. If you want to keep the sign in proportion with itself while you resize, you must hold SHIFT
as you resize it.

In the example below, we start with a regular sign, then resize it twice without holding shift. The final resized sign did make use
of the shift key, ensuring it is kept in proportion.

Figure 11.8 Only the one on the far right was resized whilst holding the shift key keeping it in proportion
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11.3.4 Sign stands
All sign devices can display an adjustable stand icon to specify their exact position and orientation.

When a sign is selected, a Sign stand icon will display to the left of the sign, which functions as a control point for adding new
stands linked to that sign. While the sign is selected, left-click and drag the stand icon to the desired position and release to
drop in place. To adjust the orientation of the sign stand, simply left-click and move the red control point extending off the front
to the desired orientation.

To move the sign stand again, just select the stand then left click the blue control point and drag to the new position.

Figure 11.9 Sign stand tool

11.3.4.1 Sign stand customization

Sign stands can be customized by adjusting style options in the Properties palette.

When the sign stand is selected you can customize its properties such as the color, size and symbol.

You can also create your own custom object to use as a sign stand, as seen in Figure 11.11
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Figure 11.10 Customize sign stand

11.3.4.1.1 Create a custom sign stand

To add a custom object to your sign stand list, simply create the object using any of the primitive/shape tools available in
RapidPlan.

Once the created object is grouped together, you can Right click > Save > As custom sign stand

The new object will then be saved to your Symbol list for use as a sign stand.

Figure 11.11 Custom sign stand

11.3.4.2 Sign stand connector

All sign stand connections can display arrows for better identification on your plan.

To enable a sign stand connector arrow, click the sign, then you can adjust styling options in the 'Stand connection' subheading
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in the Properties palette.

You can enable the connector arrow to display on the sign end, stand end or both.

Figure 11.12 Stand connection

11.3.5 Choosing the Displayed Variation
Because there are often multiple versions of the same sign, you need to tell RapidPlan which version you want to use on your
plan if the default variation is not suitable (by default, the standard sign with no code will be displayed). Changing the variation
is easy.

To set a different variation of a selected sign:

Select the sign and go to the Properties Palette.

Make changes to sign variations as necessary. I will change the sign to allow Fax Mode (no color) and to show it's sign
code as follows.
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Figure 11.13 Changing a Signs Properties

Note: To change the variations to all your signs within the plan, simply use the Toolbar and click on Toggle Color/Fax
mode or Sign Designation as explained in chapter 4 of this User Manual. This option will save you lots of time if all the
signs are to be changed
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Chapter 12 Creating Your Own Signs
Complete freedom...

One of the very powerful features RapidPlan has to offer is the capability to create new signs from inside the program itself.
Basic users may only wish to create basic signs for inclusion on their plans, and may not want to save them back into the sign
galleries. More advanced users however may wish to create different versions of each sign, with sign codes, multiple color
schemes (day Vs night etc.) and so on. This Chapter handles both cases.

Creating and saving your sign isn't difficult, but it does take some practice. Every sign inside RapidPlan was built using these
techniques, so if we can do it, so can you! This chapter does contain some advanced techniques that are covered elsewhere in
the user manual. It is a section recommended for more proficient users who are comfortable with the objects and
grouping/ungrouping and file manipulation (load, save, etc.).

RapidPlan signs are made in RapidPlan

That's right - every sign inside RapidPlan has been created from within the program, so you can use the same tools we did to
create your own signs. It also means that you can save valuable time by simply editing the existing signs in the package to
make new ones.

12.1 What is a Sign Made of?
Before we launch into creating a sign, it's important to understand what the signs are actually made of. Every sign inside
RapidPlan has been built up from basic items in the Tools palette (from the Shapes, Lines and Text tabs). Most sign faces are a
Rounded Rectangle, the text is a Text object and irregular shapes are made out of filled Polygons, Filled Beziers, Ellipses
and Rectangles. The items are then grouped and saved.

A couple of examples illustrate how the primitives are used:

Figure 12.1 The Basic Elements of Sign Making

If you aren't familiar with these base objects and how they work, see Chapter 10. It will be considered assumed knowledge for
this chapter.
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12.2 Contents of the sign file
The basic shapes and items make up the sign images, but now we need to understand how the signs are actually stored on
your computer. Quite simply, every sign in RapidPlan has its own file on the computer and stored in each file is the sign, plus all
of its variations.

12.2.1 Sign Variations
So what are "variations" and why are they important?

Well as you are probably aware by now, RapidPlan has a Fax mode which converts your entire plan to pure black and white for
to aid faxing. Of course, this black and white mode also includes the signs.

RapidPlan doesn't do this automatically, though. There is actually a separate sign (stored in the same file) that was created
using black and white objects, that is linked to the base sign. When Fax mode is selected, RapidPlan replaces the colored sign
on the canvas with the black and white variation from the same file.

Similarly, when the Sign designation mode is enabled, and the signs on the plan display their codes, it's because another
variation of that sign, containing the code has been built and stored.

Put the variations together and you now have four signs to make one completely functional RapidPlan sign file.

Figure 12.2 Sign Variations

12.2.1.1 You don't have to Build all four Variations

You might choose to only create the base sign and ignore the black and white and code designation variations. That's fine - it
just means that if you select either of those two modes, your sign will just stay the same.

12.2.1.2 Some Signs have more than four Variations

Some of the RapidPlan signs have many more variations - usually because there are different configurations of signs in
different sizes that we have included. An example is below. Note that for each of these color variations, there is a black and
white equivalent.

Figure 12.3 Sign Variations in Size
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12.3 Creating your Sign
You should now have a good understanding of what is inside a RapidPlan sign file, so now we can go ahead and make one.

The basic steps for creating a sign are:

Create your base sign
Create the black and white version
Save the base sign
Create and save the variations

For the next section of the chapter, we will continue on in a tutorial style fashion to illustrate the steps. In order to better
illustrate the process, we will be creating the fictitious sign shown below.

Figure 12.4 The Fictitious Sign we will Create

12.3.1 Create a Base Sign
There are two methods that you can use to create your base sign. You can either start from scratch with new basic shapes, or
you can ungroup an existing sign and use that as a template.

Starting by Editing another Sign

If your new sign is to be similar in appearance to an existing sign, or even if just the sign face is to be the same, it probably
makes sense to use the existing sign as a base. Drop it onto the canvas, ungroup it and delete any unwanted elements.

Figure 12.5 The Base Sign (Left) is Ungrouped (Center) and the Text Deleted Leaving a Suitable Frame to Work on (Right)
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Starting from Scratch

If you want to start from scratch, there are a couple of guidelines you should adhere to:

Sign frame: You should ensure that the line stroke width for the frame of your sign is 1.5 pt or above.
Size: Try and keep you signs roughly the same size as the original ones packaged with RapidPlan.
Font: Whilst the font isn't critical, the size is. Try to keep your font to a minimum 8pt or above, bold setting (all the default
signs use Arial).

Using Components from Other Signs

You aren't limited to just using the frame of other signs - if there is a graphic on any of the other signs in the package, you can
use that too. Simply ungroup the sign and move the elements that you need onto your own new sign.

Completing your Sign

When you have finished creating your sign, drag a selection box around your sign and select the Group objects icon in the
toolbar , CTRL + G or right click and select Group objects.
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12.3.2 Creating Variations of your Sign
Creating variations for your custom sign is made very simple using the Sign Editor Palette in RapidPlan.

In RapidPlan you can quickly edit text in signs. Just double-click on any text object that's part of a group or sign to edit it in-
place.

Figure 12.6 Double click to edit sign text

12.3.2.1 The Sign Editor

To open the Sign Editor, select View and tick the Sign Editor box. The palette will then appear at the base of your screen.

Figure 12.7 Opening the Sign Editor Palette
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How to use the Sign Editor

In the Sign Editor you can:

Produce and Save Sign Variations

Edit Sign Variations

Add a Sign Description

Add Sign Codes

Add Sign Sizes

Figure 12.8 The Sign Editor Palette

Opening a Sign into Sign Editor

To open a sign in the Sign Editor you have two options;

1. Select "Open Sign" option - use to access saved files from your computer
2. Select "Import Sign Variation From Diagram" option - use to open a sign from your canvas

Once you have constructed your base sign in RapidPlan, select the sign on the canvas and select Import Sign Variation From
Diagram in the Sign Editor. As you can see the editor will immediately provide a Fax Mode version of your sign for you.

Figure 12.9 Importing Sign From Canvas to the Sign Editor
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Editing Sign Variations in Sign Editor

Now that there are two signs, your standard sign and the fax mode variation, you can edit them as separate signs.

To do this either click on the desired sign directly in Sign Editor which will take you to the quick edit window, or select the Edit
Sign Variation icon and select the sign from there.

Figure 12.10 Quick Edit Sign Variation Option

As you can see in Figure 12.10, the Quick Edit window is the same as discussed in other sections of RapidPlan, where you
change the object's properties as usual.

Adding Sign Description, Codes and Sizes to your Sign

Adding a description for you sign, and/or codes and sign sizes is very easy in the Sign Editor.

214



To Add a Designation Code to your Sign:

Enter your desired code in the section below Sign Codes.

Select Add.

Once you have completed your sign, select Save to Library to save your sign and all its variations to the Sign Palette.

Figure 12.11 Adding a Code to your Sign

Note: You must save your sign (either to your computer or to the Signs Palette in order to use all of its edited variations.

Saving your Sign and its Variations

In the Sign Editor you can save your sign and variations to your computer by selecting the Save As... icon in the Sign Editor
Palette or you can choose to Save to Sign Library where you can choose its location within the Sign Palette. For example, in
the image below the sign is being saved to the NSW package under the Custom tab in the Signs Palette. All of the sign's
variations will be saved here.

Figure 12.12 Save to Sign Library

Note: Toggle Fax and Sign Codes modes from the Options toolbar to see your completed sign with all the variations we've
created.

12.3.2.2 A Faster Way to Save Signs (Right Click > Save)

RapidPlan has a much faster and easier way to save signs when you don't need to save and edit different variations.

Using Save from the context menu allows you to save a group as a sign to the Custom tab of the Signs Palette. It is a simple
process, but doesn't afford the power or flexibility that the Sign Editor allows.

In some regards, it is the "lazy man's" sign creation tool - but it is equally suited to less sophisticated users who don't need or
are unable to create signs using the full sign creation process.
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How to Save from the context menu:

Ensure all of the elements of your sign are grouped.

Right click on the group and select Save from the context menu that appears.

Figure 12.13 Saving a Sign from the Context Menu

In this save option you can enter a name for the sign, a sign code and a description. You can also select whether to save it
to the Custom tab or to a file.

Figure 12.14 Save Sign Option
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12.4 Editing Existing Signs
You also have the option of editing the signs that are shipped with RapidPlan. Generally speaking, this isn't going to be
necessary, but in some instances people do feel the need to make an alteration.

Simply save the sign to a different filename and input the details of your new sign within the Save Sign screen or edit
variations in the Sign Editor. This is also a technique you may use if you wish to make alterations to signs that you have
created.

12.4.1 Editing Signs from the Properties Palette
When a sign is selected, look within the properties palette to edit any information you want. Within the Properties palette you
can:

Toggle color on or off to view black and white variation.

Toggle code on or off to view the sign code.

Toggle size on or off (This works only if a size was added within the Sign Editor Palette).

Change the Name Type in the Legend & Manifest section. Whatever you change the name type to will be how it is
displayed within the manifest and/or legend.

Toggle Manifest entry and Legend entry True or False.

Figure 12.15 Changing Sign Properties
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Chapter 13 Using Layers
Many schemes are on just one road base...

There will be a lot of cases where you will need to create more than one plan for a job, such as when you have multiple stages
of works that need to be performed on different areas of the roadway. A good example of this is resurfacing; first, the traffic is
diverted onto the right side of the road so that the left side can be asphalted, then the scheme is reversed. Some road bodies
will require plans for each stage, and that's why RapidPlan offers you multiple layers on your plan. Putting the road on the
background and each traffic scheme on each subsequent layer means that you only need to draw your road once.

13.1 The Structure of the RapidPlan Layers
Imagine the layers as a set of overhead transparencies placed one on top of the other. The transparencies can be added and
taken away at will (we do this in RapidPlan by changing their visibility status) meaning that at any one time you can choose to
see either one or many layers at the same time.

By default, every plan starts with only one layer; the Background. Unlike all other layers that you add to your plan, the
Background cant be removed.

13.2 Accessing the Layer Tools
The layer tools are all housed on the Layers palette. From here you can select each of the layer functions and rename any layers
that you need to. If the Layers palette is not visible just below the Properties palette, simply click on View > Layers List box
from the main toolbar.

Figure 13.1 The Layers Palette details

Note: Hovering over each icon will explain their functions
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13.3 Functions of the Layers
There are 7 general layer functions that you will use;

Adding
Removing
Flattening
Hiding/Showing
Locking/Unlocking
Moving Layers
Color Mode

13.3.1 Adding Layers
Adding a layer is as simple as clicking the Add Layer button on the toolbar.

You will see a new layer name appear in the Layer selector box on the main toolbar. Anything you now draw will be placed on
that new layer. You will also notice that you can no longer click on any of the items stored on other layers.

This layer characteristic is especially useful if your background is complicated and has many component pieces on it (such as
lane markings/corners/etc.) and you need to drop traffic control elements over the top. It means that you wont inadvertently
pick up road structures for instance, when you are trying to alter a placed cone or barricade line.

13.3.2 Removing Layers
To delete a layer, simply ensure that you are on the layer that you wish to delete by checking in the Layer selector then click the
Delete Layer button on the toolbar. Be careful though, because once a layer is deleted, it cant be undone.

Note: All objects on that layer will also be deleted.

13.3.3 Flattening Layers
To merge all of your layers into one layer, simply select the Flatten Layers button. This will put all of the objects on your plan
into one layer.

13.3.4 Hiding/Showing Layers
One of the key benefits of multiple layered plans is the ability to show or hide different layers at different times. To show or
hide a layer is very simple. Just select the layer that you want to hide or show from the Layer selector then click the Toggle
Layer Visibility button on the toolbar (the blue eye).

13.3.5 Locking/Unlocking Layers
Sometimes, when you are finished drawing a layer you might want to lock it, to ensure you don't accidentally change your
completed work. To do this, simply select the layer you need, then hit the Lock/unlock layer button on the toolbar.

13.3.6 Moving Layers
Within the Layers palette, you can move selected layers up or down for easier access or you have the option of clicking on Send
to layer from the context menu which will be discussed later.
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13.3.7 Color Mode
You can select each separate layer to be in color mode or fax mode by clicking the Toggle Layer Color Mode button.

Figure 13.2 The Toggle Layer Color Icon

Note: Layers can be copied, duplicated and objects within the layer can be rotated at an angle specified by the user. Layers can
also be copied to another plan. These actions can be done by right clicking on the layer name and selecting from the list of
options that appear.

13.4 Renaming Layers
Renaming layers is useful because it allows you to better organize your file around what part of the works your layer focuses
on. For instance, you might rename layers as per the below table:

Figure 13.3 Renaming Layer Examples

To rename a layer in your plan:

Double click on the desired layer from the Layer Selector (or Right click and select Rename). The name of the layer is
automatically highlighted, ready for change.
Click inside the layer selector box and type in the new name for your layer.
Either press Enter or simply click back out onto the canvas. Your new name is saved.
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13.5 Moving Objects between Layers
There will be occasions where you want to move an object (or group of objects) between different layers. There are two ways to
do this - using the Send to Layer function or simply with copy and paste.

13.5.1 The Send to Layer Function
The Send to Layer function allows you to move objects directly from one layer to another. You can elect to move one or more
objects at a time. The advantage of this method is that it doesn't move the location of the moved items on the page, so it
appears on its new layer, in the same place.

To use the Send to Layer function:

Select the object or objects that you wish to move.

Right click on the object (or one of the objects if there are more than one) and select Send to Layer. A list of available
layers will appear.

Select the layer that you wish to send the object(s) to.

Figure 13.4 Moving Object between Layers by Send to Layer Function

Note: You can also select Create new layer to create a new one to send to.
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13.5.2 The Cut/Paste Method of Changing Layers
This method of shifting between layers is to simply cut or copy the desired objects from one layer and paste them to another.
This option is best if you want to duplicate items from one layer to the next.

To cut/copy and paste items to a new layer:

1. Select the object(s) you wish to move.
2. Cut or copy your selection:

To move, use Edit > Cut from the main menu (or press CTRL + X)
To copy, use Edit > Copy from the main menu (or press CTRL + C)

3. Move to the desired layer that you wish to paste the objects using the Layer Selector box.
4. Paste your objects:

If you don't care where they are pasted on the page, either press CTRL + V or select Edit > Paste from the main menu.

13.5.3 Multi-layer snapping
This method of snapping allows you to snap to objects on all visible layers. This is particularly useful when drawing complex
plans with multiple stages/layers, as it allows hassle-free snapping to base stage objects like road lanes and edges.

Hold Ctrl+Alt while drawing or transforming objects to allow snapping to objects on all layers that are not hidden.
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13.6 Making the Most out of Layers
Users who master using layers will find themselves considerably more productive than those who do not. As described earlier,
the main (but not sole) advantage offered by layers is the ability to produce multiple plans on the same road base map, but
more experienced users will figure out more productive ways to utilize layer functionality.

13.6.1 General Guidelines when using Layers
Here are a few general guidelines that will help you make the most out of the layer functions.

13.6.1.1 Always keep your Roadway the Background

Keeping your road on the background is almost always the most sensible place. Reordering layers in RapidPlan is possible as
described above, but keeping your roads on the background will be easiest since whichever layer is listed at the top of the list
will always be drawn on the canvas first - all other items on following layers are drawn in subsequent order. This means that
unless you want your signs and devices to appear under the road, it should be on the bottom layer.

Figure 13.5 The Importance of Layer Order

Note: In the above example objects are in Layer 1 and the road is in Layer 2.

13.6.1.2 Consider using at least one other Layer at all times

Even if your plan is to have only one traffic scheme on your road base, it's still usually a very good idea to have your traffic
scheme on a separate layer to the road. The reason for this is simple: Once you are working on a given layer, you can't
accidentally change, move or even select an object on another layer. This has the obvious advantage of making, selecting, and
altering objects (particularly small ones) which overlap other items on your road base (like line markings/corner pieces/traffic
islands) much easier.

It also means that if you decide you really aren't happy with the traffic guidance scheme (or need to completely change it
because of feedback from a road body) you can simply wipe the traffic guidance scheme layer in a single button stroke, rather
than individually pick through and delete each item one by one.
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13.6.1.3 For Multi-Stage Works, keep each Scheme in the same File

The benefits of this are obvious; one file with each stage of the works neatly packaged in a single place.

13.6.1.4 Name your Layers appropriately

Two weeks after drawing the plan you will probably remember what each of the 6 schemes in your plan was designed for, but
what about a year down the track when you are re-excavating the same site? Chances are you might have forgotten (or another
user is retrieving the plans from an old site). So name your layers appropriately. Some simple, self-explanatory names might
be:

Stage 1 lane closure for valve removal
4 week advance notice of closure
Footpath closure for re-concreting
Aftercare signage before spray seal

13.6.1.5 DON'T have different Road Sections on different Layers

This is especially important. It's never wise to have more than one road section in the same file. Doing so is likely to lead to
confusion, when you have say 4 road sections, with 3 traffic schemes each. Unless you name your layers very carefully, you are
likely to loose track of which layer scheme corresponds to which road base.

13.6.1.6 Carefully plan which elements overlap Layers to avoid unnecessary reproduction

Sometimes, there will be elements that you wish to draw on multiple layers.

Take a look at this simple example below:

It is a simple, but very typical situation where there are works to be completed across two stages. In each case, four of the five
signs are common (Road Work Next 2km, Symbolic Worker, Rough Surface and End Road Work) as are the distances between
each of the elements on the plan.

Figure 13.6 Two different Layers of a Plan

The only objects that change on the plan are the Merge Right and Merge Left signs and the work site location, cones and
arrow trailer.
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Therefore, it would be wise to:

Create the road and common signs on the background

Place the left lane specific items on Layer 1

Place the right lane specific items on Layer 2

Figure 13.7 Suggested Layout for the three Layers on the Plan

Notice in the image that there are no items that have been drawn more than once, meaning that the layout is optimized

13.7 Plan Stages
Several phases of works at one location can now be included in a single traffic plan, using the Plan Stages feature.

Each plan stage has its own set of layers and print regions, while the base layer is used for elements shared across all the other
stages (e.g., road network, permanent markings).

13.7.1 Setting up plan stages

Selecting the Enable plan stages button will activate Plan stages on the layer you currently have selected.
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Figure 13.8 Enable Plan Stages

When you have enabled the Plan stages on a particular layer, your layers tab will be separated into Stage layers and Base
layers.

The Base layers are where all of the permanent road objects, signs and markings will be displayed. The Stage layers are used
for showing objects in different phases. For example, you can have one base layer with two stage layers - daytime setup and
nighttime setup.

Figure 13.9 Plan Stages Options

Select stage allows you change between your different stages. Add/remove stage allows you to create new stages with the
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click of a button. It also remove stages, if necessary. Edit stage properties allows you to name the stage and attach specific
comments to it.

13.7.2 Plan stages in action

Below is an example of how a plan stages setup might look.

Plan objects are set up on the base layer. These objects are always visible. Whilst daytime and nighttime stages contain different
objects.

Figure 13.10 The Base Layer

The following images show the two stages (daytime and nighttime)
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Figure 13.11 Day Time Stage

Figure 13.12 Night Time Stage

13.7.3 Printing or exporting stages

Printing or exporting your plan stages is made a lot easier with the quick access right click menu. Simply right click to open the
menu and then either select Print or Export all regions.
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Figure 13.13 Canvas Print Menu

This will open up a dialogue box, with the plan stages automatically displaying in each layer based on how you arranged them.
You can then select the checkbox to have all stages displaying in the one PDF file.

When ready, select Export and RapidPlan will save all of the plan stages into one PDF document.

Figure 13.14 Export Plan Stages
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Chapter 14 Integrated Mapping
Now that you have an understanding of how to use the tools available to you in RapidPlan, we can discuss building your entire
plan with the integrated mapping feature.

14.1 Accessing Integrated Mapping
In Chapter 4 we covered how to start a new plan from different plan types, so in this section we will focus on aspects only
relevant to integrated mapping.

To access the integrated mapping feature:

Select the New Plan Wizard on the Welcome screen.

In step 1 select a Base Map plan.

In step 2 you can specify a plan scale or leave it as the default scale.

Now specify a job location. You can search location by street address or longitudinal and latitudinal coordinates.

The red cross in the center of the map points to the job location, scroll the map as necessary to the desired location.

Once the scale and location are set, select Create Plan at the top.

Figure 14.1 Searching for Job Location

Note: As it is an unrestricted canvas, you can scroll and zoom to anywhere on the map you like. This means it can be
important to be fairly precise when setting your job location in step 2 so that you can find the exact spot when searching
plans by location in the future.
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Figure 14.2 New Base Map Plan
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14.2 Map Properties
The Base Maps tab in the plan's Properties Palette allows you to control whether to show the map on the plan, choosing a
Provider for the map and the opacity of the map.

14.2.1 Base Map Provider
Eight base map providers are available to all RapidPlan users. These are:

1. Omniscale - Street view, provided by Omniscale
2. Google Satellite - Satellite imagery, provided by Google
3. Google Hybrid (light)- Satellite imagery with street names and annotations, provided by Google
4. Google Hybrid (full) - Satellite imagery with street names, annotations and road outlines, provided by Google
5. Bing Satellite - Satellite imagery, provided by Bing
6. Bing Hybrid - Satellite imagery with street names and annotations, provided by Bing
7. ArcGIS World - Satellite imagery, provided by Esri
8. ArcGIS Hybrid - Satellite imagery with street names and annotations, provided by Esri

There's also a number of region-specific mapping providers available in the software, depending on which country version you
have access to.

To view these additional mapping providers, go to the Base map section of the Properties palette. Select the Provider
dropdown menu. Click More providers.... In the dialogue box (displayed in Figure 14.3), check the providers you want to use.
These will then become visible in the dropdown menu.

Please note: Access to content from NearMap and Metromap (both available to users in USA, Australia and New Zealand)
requires a paid subscription to those services.

232



Figure 14.3 Base map providers
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14.2.2 Custom Base Map Provider
You can also add your own custom map provider. It is disabled by default and to change it go on Properties palette in the Base
map section open Provider selection dropdown, click More providers.... On bottom of the list check Custom ArcGIS Service
and press Save button. Now on Provider selection dropdown click on Custom ArcGIS Service which will open a new window
where you can enter your custom map provider Service address. Press Get Details button and if your service address is valid,
you can save it and/or add it to bookmarks.

Figure 14.4 Custom ArcGIS Service
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14.2.3 Importing Georeferenced Images
14.2.3.1 Requirements

RapidPlan version >= 3.2
Supported data formats: standard World File, MapInfo raster .TAB file
Spatial reference: ESRI 102100/3857 (Web Mercator)

14.2.3.2 Importing via New Plan Wizard

In RapidPlan, go to File > New Plan Wizard. Select Base map as the plan type.

Figure 14.5 Importing via New Plan Wizard

Click Add files... and select the images you want to import. Remember that you can only import images accompanied by
georeferenced data, either in a World File format (for example for a .jpg image the corresponding world file will have a .jgw
extension) or a MapInfo .TAB format. You can also select zip files that contain both the image and the georeferenced file (such
as files exported from NearMap) - these will be extracted automatically.

The files you selected will appear on the scrollable list, displaying data extracted from the georeferenced file: location, scale and
bearing. By checking the box on the right side of the list you can select which image is to be placed at the center of your plan.
The selected image will also be used to preset the plan location, scale and bearing (other images will have their scale and
rotation automatically adjusted to match).

Once you've selected the files, scroll up and click the Next button. In the second Wizard step you can confirm that your plan
location and scale have been set correctly, then click Create Plan. The created plan will contain a dedicated Georeferenced
Images layer with all the imported images automatically arranged to form a continuous base map.
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Figure 14.6 Georeferenced Image

14.2.3.3 Importing to an existing plan

Once you have created a base map plan using the New Plan Wizard you can add additional georeferenced images to it by
clicking Tools > Import > Georeferenced images. Select the files you want to import and they will be laid out on the plan
automatically, adjusted to match the plan scale and bearing. Note that the files you're adding must cover areas adjacent to the
plan location.

You can also import georeferenced images to blank canvas plans. Such plans don't have a scale and location set, so these
values will be copied from the image(s) you're importing.
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14.2.3.4 Exporting from NearMap

In order to create georeferenced images from NearMap, open the NearMap viewer, navigate to your desired location and select
the area you want to export. Click the Export button at the top, select Georeferenced image format and make sure the
projection is set to WSG84 / Spherical Mercator. Click Download files - this will download a zip file containing both the
exported image and its georeferenced file. The zip file can be imported to RapidPlan as described above (its contents will get
extracted automatically). You can also export multiple adjacent areas into separate zip files, then import them into RapidPlan all
together.

Figure 14.7 NearMap export
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14.2.3.5 Exporting from MapInfo Pro

In MapInfo Pro, navigate to the area you want to export and click Output > Save Image. In the options dialog, check the
Create a Geographically Referenced Tab File box, then click Save. The image will be saved together with an accompanying
.TAB file, allowing it to be imported to RapidPlan as described above. You can also export multiple adjacent areas into separate
files, then import them into RapidPlan all together.

Figure 14.8 Exporting from MapInfo Pro

14.2.3.6 Image georeferencing tool
This tool can be used to georeference any map image imported into RapidPlan (from Google, etc). Specify the coordinates of
the image by pairing them with locations on the live map, as shown in Figure 14.9 . This ensures the image is accurately
positioned and scale set.

To utilize this tool go to Tools > Advanced tools > Georeference image files. The best points to reference are road
edges/crossings, buildings edges for your location/coordinates in the live map (this will need to match the imported image).
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Figure 14.9 Loading image

Once you have loaded the image and found your location on the live map, left click to position each map correctly, then, if
required, scroll in/out to accurately set the zoom level - so both maps match accurately, as shown in Figure 14.10.

Then, you need to specify two different pixel/reference points on the map. Do this by right clicking to add a red cross (setting
the first pixel point) on each map. Then right click again on each map, to add a blue cross (setting a second pixel point).

Note: Search for points that can be positioned precisely on both maps. Intersections can be useful, as shown in Figure 14.10.
Road and building edges can also be used.

Once the points are positioned, click Save Georeference, to save a World File (containing the georeference information) for your
map.
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Figure 14.10 Georeferencing image

240



14.3 Creating a Plan on a Base Map
You are now ready to add your necessary features to the plan...

Create your plan as normal on top of the base map. An example is provided below.

Figure 14.11 A Simple Plan on a Base Map
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14.4 Printing with the Base Map
After you have completed your plan onto your base map, if you try to print you may notice that the base map is not printed
with your plan. This is because the base map preview is not a part of the diagram.

In order to use the map as the plan's background so it is available when printing or in offline mode, you can use the Import
Aerial Photos tool.

14.4.1 Importing Aerial Photos
Right click on the print region icon (the printer in the bottom left of the print region).

Select Import Aerial Photos.

Then you can disable the base map preview with the Toggle Base Map Visibility icon in the toolbar so you are only
working with the printable map(see Figure 14.13).

Figure 14.12 Importing Aerial Photos in the Print Region
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Figure 14.13 Base Map Preview turned Off

Note: Individual tiles can also be imported individually by right clicking on the area you want to import and selecting
Import Aerial Photo.
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14.4.2 Importing Photos for a Custom Area of the Plan
You can also import aerial photos for a custom area of the plan outside of the Print Region.

To Import Custom Area:

Select Tools > Import > Aerial Photos.

The cursor will become a cross for you to drag your mouse over the plan, selecting your custom area.

Figure 14.14 Importing Aerial Photos for a Custom Area Step 1

Figure 14.15 Importing Aerial Photos for a Custom Area Step 2
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14.5 Layers with Base Map
RapidPlan automatically places any imported aerial photos to an Aerial Photos layer. This ensures that the aerial photos
remain the bottom layer of your plan, as the background.

Figure 14.16 The Aerial Photos Layer

14.5.1 Moving a Section of Map to another Layer
When on the Aerial Photos layer, you can import tiles of the photo for extra coverage.

To import a tile sized area of the aerial photo, just double click on the area of the plan.

However, you cannot move or transform these tiles on this layer as the layer needs to keep track of the map region. To
manipulate a tile, for example to create a separate section of the plan with a different scale, you need to copy and paste the tiles
onto a different layer.

To select and move tiles to a different layer:

Select the tiles you want to move by clicking once on the tile, (hold SHIFT and continue to click other tiles if you want to
move multiple at a time).

Right click, select copy.

Select the layer you wish to move them to.

Right click in new layer and select paste.
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Figure 14.17 Resizing Aerial Tiles on New Layer

Note: The tiles will now be fully editable images, like any other object in RapidPlan.
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14.6 Using Integrated Mapping as a Stencil
You can also use integrated mapping as a guide when drawing your road layout without using the map as an imported
background. The mapping can be used in preview form to import roads and draw lane markings to form the base of your
plan, then hide the mapping to work further on your plan. This can be beneficial as it is more readable when printed and easier
to convert to fax mode.

14.6.1 Importing Roads
Importing roads onto integrated mapping creates a road object with properties that can be manipulated.

There are three ways of importing your roads;

1. Import all roads in Print Region by right clicking on the print region printer icon and selecting Import Roads.

2. Select a custom area via Tools > Import > Road Layout to import all roads in the custom area.

3. Select individual roads by right clicking on the road and selecting Import Roads.

Figure 14.18 Imported Roads
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14.6.2 Creating your Plan by Importing the Roads
As you can see in above in Figure 14.18 the imported road objects do not fit the actual roads in the satellite image. This section
will cover developing your plan to match the base map using the above example.

14.6.2.1 Matching the Width of the Roads

As you have a set scale, you can accurately measure the width of the satellite road with a distance marker tool and adjust the
road object properties accordingly.

Figure 14.19 Measuring and Adjust Road Width
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14.6.2.2 Matching Road Markings

Once your road widths are adequate, you may need to make some manual adjustments, such as adding Road Corners and
Lane Markings.

To adjust the road objects to match the satellite image:

1. Firstly, adjust the road layer opacity in the layers list to see the satellite image through the road object. This will make
transferring lane markings much easier.

Figure 14.20 Changing Road Opacity to see Satellite Image Below

2. You may need to adjust the roads by adding road corners or turning lanes, etc. Make sure to copy the style of the road
to each road tool by copying the style from the main road, selecting the new object and using CTRL + SHIFT +V to paste
the style.

For more information of how to use Road tools, see Chapter 6 and Chapter 7.

In the image below, the provider has been changed to the Omniscale, so you can see the road corners are the same style as
the road.
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Figure 14.21 Road Corners have been Added and the Road Style Transferred

Note: The Road Corners were placed with the satellite provider to trace the exact shape.

3. When you are satisfied with your roads, add other necessary features such as lane markings.

For more information on how to use Lane Markers, see Chapter 7.

Figure 14.22 Completed Plan Satellite on Show (Left) Completed Plan No Satellite (Right)

4. Once your base road layout is drawn up, you can print it, use the fax mode icon to convert it or start adding your traffic
management information.

14.6.3 Importing road names and speed limits

After using the Roads Import tool, right-click on the imported roads and select "Import road data" as seen below in Figure
14.21
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Figure 14.23 Right click menu

After the road data is imported it will display as shown in Figure 14.22. If the required data is available in OpenStreetMaps, your
roads will get annotated with names and speed limit signs.

Figure 14.24 Imported street data
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